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LICENSE AGREEMENT
By opening this sealed disk package, you are agreeing to be bound by the terms of this Agreement.

This product is remote control software package, herein refer to as M.A.X. (“Product”) for use with a Digital Recording
Mixer, Panasonic model WR-DA7(“Unit”). This Agreement constitutes the complete agreement between you and
MATSUSHITA COMMUNICATION INDUSTRIAL CO., LTD. (“LICENSOR”) about this Product.

If you do not agree to the terms of this Agreement, do not open the disk package. Promptly return the unopened
package and any other materials that are part of this Product together with your proof of payment within 10 days to the
place where you obtained it for full refund.

1. License Grant

In consideration of payment of the license fee, which is part of the price you paid for this Product, LICENSOR grants to you, the
LICENSEE, a non-exclusive right to use and display this copy of the Product only on a single computer which remotely controls a
single Unit.

LICENSOR reserves all rights not expressly granted to the LICENSEE.

2. Ownership

As the LICENSEE, you own the magnetic media on which the Product is originally or subsequently recorded or fixed, but
LICENSOR and JLCooper Electronics (“JLC”) who have licensed portions of the Product to LICENSEE retain title to and
ownership in the software program of the Product. This License is not a sale of original software program of the Product, or any
portion or copy of it.

3. Copy Registration

The Product and the accompanying materials are copyrighted and contain proprietary information and trade secrets of the
LICENSOR and others. Unauthorized copying of the Product even if modified, merged, or included with other software, or of
the written materials, is expressly forbidden. You may be held legally responsible for any infringement of intellectual property rights
that is caused or encouraged by your failure to abide by the terms of this Agreement.

4. Permitted Users

The software, user’s manual and documentation are licensed to you only. You may not rent or lease the Product, but you may
transfer the software and accompanying written materials on a permanent basis to a transferee of your Unit provided you retain no
copies and recipient agrees to the terms of this Agreement.

You may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the Product.
Written materials provided to you may not be modified, adapted, translated or used to create derivative works without the prior
written consent of LICENSOR.

5. Termination

This Agreement is effective until terminated.

This Agreement will terminate automatically without notice from LICENSOR if you fail to comply with any provision contained
herein. Upon termination, you shall destroy the written materials, the Product, and all copies of them, in part and in whole,
including modified copies, if any.

6. Miscellaneous

This Agreement is governed by the laws of either Japan or the Commonwealth of Massachusetts. In the case of a conflict, the law
applies that is more likely to uphold the enforceability of Agreement.

7. Disclaimer and Limited Warranty

LICENSOR warrants the disk on which the Product is furnished to be free from defects in materials and workmanship under
normal use for a period of thirty (30) days from the date of delivery to you as evidenced by a copy of your receipt.

LICENSOR’s entire liability and your exclusive remedy as to the disk shall be replacement of the disk that does not meet
LICENSOR’s Limited Warranty and which is returned to LICENSOR with a copy of receipt. If failure of any disk has resulted from
accident, abuse, or misapplication, LICENSOR shall have no responsibility to replace the disk. Any replacement disk will be
warranted for the remainder of the original warranty period.

EXCEPT AS EXPRESSLY PROVIDED ABOVE, THE PRODUCT, USER’S MANUAL AND DOCUMENTATION ARE PROVIDED
“AS IS”. LICENSOR DOES NOT MARK ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

The entire risk as to the quality and performance of the Product, user’s manual, and documentation is with you. LICENSOR does
not warrant that the functions contained in the Product will meet your requirements or that the operation of the Product will be
uninterrupted or error free.

LICENSOR SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES
(INCLUDING DAMAGES FROM LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT EVEN IF
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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READ THIS FIRST!

The Panasonic WR-DA7 Mixer be
“Version 1.10” or higher 
to operate with MAX.

You can find out what version your DA7 is 

by looking at the display screen on the mixer.  When the DA7 is

powered up, it displays the current version of software in the

lower right-hand corner of the display.  If you see a V 1.10

displayed, your software is compatible.  If any version displayed

is lower, such as V 1.01 or V1.02, you must upgrade your DA7

operating system in order for MAX to operate.

If your mixer is not Version 1.10 or higher, 
it will not work with MAX.

If you need assistance to upgrade the
operating system in your DA7, please contact
Panasonic Pro Audio Technical Support for

information, or visit our web site at:

www.panasonic.com/proaudio.



PANASONIC TECHNICAL SUPPORT
(In the USA)

If you need to contact Technical Support for this or

any other Pro Audio product, 

please call 323 436-3620 Monday through Friday 

from 9am to 5pm Pacific time.

For other Panasonic Broadcast products, 

please call 800-524-1448 Monday through Friday 

9am to 5pm Eastern time.

Panasonic Broadcast & Television Systems Company

Professional Audio Division

3330 Cahuenga Boulevard

Los Angeles CA, 90068

Telephone: 323-436-3500

v i i i
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OVERVIEW
MAX is a sophisticated software package engineered to automate your

Panasonic DA7 Digital Mixer in conjunction with a Macintosh computer.

MAX provides time code-synchronized record and playback of all automatable

mixer features, including automated moving faders, surround panning,

channel on/offs, aux send levels, EQ, dynamics on/offs, and routing.

Even though your DA7 already has automation, using MAX gives you easier

and more precise mix editing. Mixes can be longer and can be saved to disk.

You can even connect two mixers to a single Macintosh creating a larger

digital console treated as a single, integrated automation system.

MAX features multiple user-designable “Custom Views”, a feature-packed Cue

List, and easy to use Graphic Editing.

The Custom View shows the positions of the faders, knobs, and switches. You

see and edit the mix as it happens by moving the mixer’s faders. You can edit

by punching in and out of fader moves, or modify existing fader moves

without replacing them. 

Overview
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Overview

The Cue List shows each automation move as an event occurring at a specific

SMPTE time. You see and edit the mix as a sequence of events. 

Individual fader moves or whole sections of a mix can be copied, cut, pasted,

and modified. 

You can even create precision fade-outs by simply typing the start and end

times into the computer.



The Graphic Editing view displays the mix as curves on a time line. You can

see multiple channels at the same time, and easily see what moves are coming

up. You edit the mix by drawing fader curves.

What’s more, you can freely change the way you view the mix, with the

Custom View, Cue List, or Graphic window, even while the mix is playing.

And you can have multiple mixes open at the same time, allowing you to

instantly compare two different mixes. You can even freely copy from one mix

and paste into another mix!

A clear indication of channel names, edit modes, grouping, and channel

on/off status, combined with a large, easy to read time code display make

mixing fast and easy.

MAX software also adds to your mixer up to 15 groups called “SoftGroups”.

Any fader on the mixer can be turned into a SoftGroup Master, in addition to

the mixer’s groups and Stereo Master. When two mixer’s are connected,

faders on one mixer can be a group master to faders on the other mixer.

Your mixer faders become a virtual Control Surface, to control and automate

signal processors and digital audio workstations. 

x i

Overview



MAX provides a clear graphic display of automated Surround Panning

positions. It also allows panning of either individual channels or the grouped

multiple channels.

Mixes reside in the Macintosh’s “RAM”. You can save the mixes to a disk,

either manually or automatically using the Auto Backup feature. 

MAX allows you to quickly create different mixes, listen to them, compare

them, save them, retrieve and modify them.

MAX also allows you to customize the software to your personal style of

mixing. You can label each fader, re-arrange the order of the faders, turn

certain features on and off, etc. This customization is saved as part of a

Preference file. Multiple Preferences files are supported, so different

engineers can each have their own preferences. 

This introduction has just scratched the surface of the power of MAX. The

following list highlights many of MAX’s key features.

The DA7 Librarian Software allows you to edit and save multiple DA7 libraries

to disk. 

x i i
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FEATURES
MAX FOR PANASONIC DA7 KEY FEATURES

• Capture “Snapshots” in Real Time. 

• Snapshots can be Individually Named

• Auto Transition Between Snapshots

• Dynamic Memory Meters Display Available Memory

• On-Screen Display of Time code Frame Rate

• Multiple Preference Files for Each Engineer or Project Type

• Single Key Access to Frequently Used Items

• OMS Compatible

• Mixer Faders Can Become MIDI Control Surface

• Real Time MIDI Recording

• Enhanced MMC

• Large Screen Support with 1024 x 768 resolution

• Automates Auxiliary MIDI Equipment like Signal Processors

• Supports MIDI Machine Control (MMC) 

• Assignable Automated On-Screen Surround Panning

• Groups Control Surround Panning

MAX GRAPHIC EDITING FEATURES

• Freely Draw Fader Levels

• Simple Free Hand or Straight Line Editing

• Copy, Paste, Clear, Moves

• Movable Current Time Indicator

• Create/Edit Markers in the Time Line

• Fader Curves Smoothly Scroll in Real Time

• Graphic Indication of Channel On/Offs

• User can Reposition Markers and Snapshots in the Time Line

• Moved Regions Snap to Markers

Features



MAX CUE LIST FEATURES

• Powerful Cue List EDL Style Editing for Precision Control 

• Cut, Copy, and Paste Mix Editing 

• Offset, Scale, Crop, and Smooth Fader Moves 

• Interpolate Moves, During Scale - Stretch Editing Operations

• Triangles Expand to reveal Microscope View of Fader Moves

• View Filter Displays Channels, Range of Time, Type of Event

• Ability to Create Events Off-Line 

• Undo and Redo on All Editing Operations

• Moving Time Line With Markers

• Revert Command

• Find Command

• Merge Mixes

• Real Time Scrolling Cue List with Time Code

• Convert Markers into Fader Moves, Channel Ons or Snapshots

• Off-Line Editing in dB or Fader Value

• Print Cue List, Markers or Track Sheet. 

• Ability to Type “Comment” Text that is Saved with the Mix

• Ability to Create Fades by Typing the Start and End Times.

DA7 LIBRARIAN FEATURES

• Ability to upload the libraries stored in DA7 to Librarian software

• Editing Library names 

• Download libraries to disk or DA7

x i v

Features 
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Chapter  1 

GETTING STARTED
COMPUTER SKILLS REQUIRED

This manual assumes that the user already possesses computer-operating

skills, particularly a familiarity with the mouse (pointing, clicking, dragging),

menus, dialogue boxes, the Desktop, the Finder, the Chooser, and other basic

Macintosh concepts. 

If you have just purchased your first Computer for the purposes of

automating your mixer, we recommend that you first read the introductory

manuals that came with your computer before starting to use the automation

system.

COMPUTER REQUIREMENTS

MAX software runs on Power Macintosh computers with a 17” minimum color

monitor. 

The minimum Macintosh configuration required to install and run MAX is a

PowerPC 7100 with at least 16 megabytes of RAM. MAX software does not run

on a Powerbook, or any 68000 series Mac.

The software was developed on System 8.1. The minimum recommended

Macintosh System version is 7.6.1 or higher.

To find out what version System you have, click on the Apple menu in the

upper left hand corner of the screen. Drag down to select “About this

Macintosh” and release. If you have an older version, contact your Apple

dealer to obtain a compatible System software version for your Macintosh.
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COMPUTER SETUP

The Chooser and AppleTalk 

Your Macintosh may or may not be connected to printers via the “AppleTalk

Network.” AppleTalk must be “Active” for printing. However, turning it on

robs processing time from the computer, and may adversely affect the way

that the MAX software responds to time code. 

Therefore it is recommended that you turn AppleTalk off while mixing with

MAX. Leave it turned off until you want to print. 

To turn AppleTalk off, select the Chooser from the Apple menu. Then click on

the AppleTalk Inactive button. 

When making AppleTalk Active or Inactive, you will see a prompt reminding

you to connect or disconnect the AppleTalk network, that is, the printer

cable.

Note: Please make sure that unused serial ports are inactive by opening the

Extensions Manager in the Control Panel on your computer.

Monitor 

MAX operates only in 256 color mode, on a 17” minimum monitor with 1024

X 768 resolution. Select Control Panels from the Apple menu. 

Select Monitors (or “Monitors and Sound”), then select 256 color. 

When you launch the software, if the color mode is not set to 256, the

software will prompt you. Click OK and MAX will set the color mode to 256

automatically. 

Memory 

Typical of Macintosh applications, the more RAM that you allocate to the

application, the longer the mix you can do.

To allocate more memory to the application, from the Finder (with the

application not running), click once only to select (highlight) the MAX icon.

Select “Get Info” from the File menu, or type command I. Then increase the

Preferred size, based on how much RAM is available in your Macintosh.

Getting Started
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Getting Started

SOFTWARE INSTALLATION

For installation, follow the steps shown below.  RAMSA MAX software and

DA7 Librarian are contained in the provided disk labeled “Mixing

Automation eXpansion Software". DA7 Librarian software will be discussed

later in Chapter 16.

1 Insert the MAX disk. Installer icon appears. 

Double-click on MAX icon if the Installer icon is not displayed.

An error message will appear if a wrong disk other than “MAX disk” is

inserted.

2 Double–click on the Installer icon to expand MAX.

3 A start-up dialogue box will appear. Click on the Continue button and

follow the on-screen directions.

4 A Password dialogue box will appear. 

Enter the password and click on the Continue button. Please find the

password indicated in an attached label on the rear cover page. The

password IS case sensitive, please type all text in capital letters.



If a wrong password is entered, a warning will appear. Clicking OK will

let you attempt to enter the password again.

5 An “Extract” dialogue box will appear. 

Select the destination folder where you want to store MAX.
Click the Extract button to begin the software installation. 

6 When the installation of MAX ends, a new “Extract” dialogue box will

appear for the DA7 Librarian program.

Select the destination folder for the DA7 Librarian.

Click the Extract button to begin the installation of the Librarian

program.

7 An ending dialogue box will appear upon successful completion of the

installation of the MAX and DA7 Librarian programs. 

Click the Quit button.

4

Getting Started
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Chapter  2 

CONNECTING THE SYSTEM
MIXER AND COMPUTER COMMUNICATION HOOKUP

If you are connecting one DA7 to your Macintosh computer, you will need a

cable (which is not provided) that connects the DA7's TO PC port connector

to your Macintosh's Modem port.

If you are connecting two Panasonic DA7s, connect the first mixer as

described above, and the second mixer's TO PC port to the Macintosh's

Printer port.

MAX Software communicates with the mixer at a very high data speed, (also

referred to as Baud Rate) using MIDI protocol.  Because Max uses this high

MIDI rate, you cannot use standard MIDI at the same time on the DA7 mixer.

SERIAL PORT

TO PC
RS422 /  485

110

OFF   ON

SERIAL PORT

TO PC
RS422 /  485

110

OFF   ON

WR-DA7 (Master) Rear Panel Macintosh

MODEM Port Printer Port

WR-DA7 (Slave) Rear Panel

Printer Cable

2x Mini DIN 8 Male, Cross-type

Printer Cable

2x Mini DIN 8 Male, Cross-type

SERIAL PORT

TO PC
RS422 /  485

110

OFF   ON

WR-DA7 Rear Panel Macintosh

MODEM Port

Printer Cable

2x Mini DIN 8 Male, Cross-type



TIME-CODE SYNC HOOKUP

The MAX System is SMPTE Time Code-driven. This means that it requires

SMPTE time code in the form of a longitudinal time code source. If your

system does not use SMPTE time code, or you would prefer to use MIDI time

code (MTC), skip down to the section on Using MTC.

The DA7 has an optional SMPTE time code reader available.  If you did not

purchase this option with your mixer, contact your DA7 dealer. 

The cable carrying the SMPTE time code signal from the device that you will

syncing to will connect directly to the SMPTE Input on the optional SMPTE /

V-SYNC card.

The SMPTE time code can come from one of several possible sources:

One track of your tape source may be pre-striped with SMPTE.

Most modern modular digital multitrack tape machines and certain hard disk

recorders can also generate SMPTE from a “sub code” track.

If two mixers are connected, send the time code into the mixer which is

connected to the Macintosh’s Printer port.

Using MTC

If OMS is installed, MAX can also sync to MIDI Time Code (MTC.) This can be

selected in the Port Setup Preferences.

MIDI HOOKUP

The MAX Software allows the mixer console to be a MIDI Controller.

MAX also features a built-in MIDI Machine Control locator.

To use this feature, connect a Macintosh MIDI Interface to the available serial

port on the Macintosh.

For example, if the mixer is connected to the Macintosh Modem Port, then

connect the MIDI Interface to the Macintosh’s Printer Port.

If you are connecting only one mixer, use the other available port for the

MIDI interface. 

Remember, you CANNOT use the DA7 MIDI port for this purpose because it

is being utilized for MAX.

6
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Connecting the System 

If you are connecting two mixers, see next page, System Connection

Examples, for Tandem Operation.

SYSTEM CONNECTION EXAMPLES

MIDI
  IN

MIDI IN

MIDI OUT
MIDI
  OUT

DA-98

TDIF

WR-DA7

INPUT 1-16

R

SR

Mic Sampler

Keyboard

SP

MONITOR 
A

AES/EBU

SP

Power
AMP

REC
OUT

2TR
A IN

DAT

A B

To PC

MODEM Port

Expansion
Software
        (Mac)

WCK MASTER
SLOT 1
(17-24ch)

TDIF-1
TDIF-1

PW-88DL

TO PC
RS422 /  485

110

OFF   ON

MIDI Interface

SERIAL PORT

WR-DA7 Rear Panel

MODEM Port Printer Port

Macintosh

For Single DA7
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Connecting the System 

WR-DA7

MIDI
  IN

MIDI
OUT

TANDMSYNC OUT

SLOT 1
(17-24ch)

(MASTER)

SLOT 2
(25-32ch)

INPUT 1-16

WORD CLOCK
OUT (75Ω=ON)

To PC

WORD
CLOCK 
IN
 (75Ω=ON)

To PC

WR-DA7

IN

SLOT 1
(17-24ch)

(SLAVE)

SLOT 2
(25-32ch)

INPUT 1-16

TANDM

WCK MASTER TDIF

DA-98

TDIF

DA-38

IN

SYNC OUT

TDIF

TDIF
IN

SYNC 
OUT

R

SR

Mic Sampler

Keyboard

R

SR

Mic Sampler

Keyboard

DA-98 ID3

DA-38

DA-38

SP

MONITOR 
A

AES/EBU

SP

Power
AMP

REC
OUT

2TR
A IN

DAT

A B

MIDI OUT

MIDI IN

PORT 2
IN/OUT

PORT 3
IN/OUT

MIDI
  IN

MIDI
OUT

OUT

PORT 1 IN

Printer Port

Modem Port

Expansion
Software
        (Mac)

MIDI
Timepiece

SLOT 3

SLOT 3

TDIF-1

TDIF-1

TDIF-1

TDIF-1

PW-88DL

PW-88DL

PW-88DL

PW-88DL

PW-
88S

PW-88S

PW-88S

(MASTER)

(SLAVE)

For Tandem Operation
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Connecting the System 

SETTING UP THE SYSTEM

Mixer Setup

The DA7 communicates with MAX via the mixer’s “TO PC” port, using a

special high-speed protocol. To enable this communication, it is essential

that several things be setup correctly in the mixer’s MIDI Setup Screen.

• Press the MIDI Button on mixer until the Setup Screen is displayed.

• Set Port Select to “TO PC”.

• Set Gen RX and Gen TX to “TO PC”.

• Enable TX and RX for PRG CHG, CTRL CHG, and SYSTEM EX.

• Set Other CMD to for Single DA7. When used in TANDEM 

operation, set to for Master and to for Slave DA7.

• Enable NRPN.

• Set MTC to MIDI.

• Set the Mixer’s BAUD RATE to 125K.

• To receive time code at the mixer, connect a source of SMPTE (on the 

optional SMPTE / V-SYNC board) or MTC into the mixer's MIDI In. 

• Go to the Automation Setup Screen and select SMPTE or MTC as the "time 

base." 

Launching Software to Verify Connections
• Turn on the Macintosh first. 

• Before launching the MAX software, be sure the mixer is turned on. 

• Launch the software by double-clicking on the MAX icon.

• Moving a fader on the mixer should cause a fader to move on the computer

monitor.

• Moving a fader with the mouse should cause a fader to move on the mixer.

For TANDEM Operation, set the
Other CMD fields as shown below.

FOR MASETER DA7

FOR SLAVE DA7



SETTING THE COMMUNICATION SPEED
The MAX software communicates with the Panasonic WR-DA7 Digital Mixer at

one of two rates; 62.5K and 125K.

To change the communication speed, select Preferences from the Edit menu.

Click on the Port Setup tab. This accesses the Communication Speed setting.

Notes:

• After changing the Communication Speed, you will need to close the

MAX software once and then restart it for some types of computers.

• When connecting with the computer, the DA7 mixer will not perform

one of functions, Auto Channel Selection assigned in the Utility

Configuration Window.

REQUIRED SETUP FOR TWO MIXERS

If you are automating two Panasonic WR-DA7 Digital Mixers using MAX:

First connect the two mixers and install the software according to the

instructions in the previous chapters.

After launching the software, select Preferences from the Edit menu. Under

General Preferences, look at the setting

“Number of consoles”.

Check whether one or two mixers are connected to the Macintosh serial

ports. 

Be sure to check two when two mixers are connected.

1 0

Connecting the System 
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Chapter  3

MAX CONTROL BAR
Common to all three main windows is the Control Bar. 

It appears at the top of the Custom Views, the Cue List, and the Graphic View. 

The Control Bar displays some frequently used buttons, controls and displays.

Auto
Turns on Auto Punch In.

Click to turn on, (the button is yellow when on).

Auto Punch in means that a selected fader in Write mode will not actually start

writing new moves until you physically moves the fader knob (up or down)

until the fader position matches the current level, called the Null point.

Touch
Turns on SoftTouch.

Click to turn on, (the button is yellow when on).

SoftTouch means that a fader will automatically become selected when you

physically moves the fader knob. It is not necessary to press a Select button.

When the fader is selected, it switches to the current Edit Mode. In other

words, if the fader is currently in Read mode, and the Edit Mode menu is set

to Write, moving a fader will automatically switch the fader from Read into

Write mode.

Mark
Click to create a Marker.

If time code is running at the time, an untitled text Marker is inserted into the

mix when you click. (It can be edited later, by renaming it, moving it, or

turning it into another kind of automation event such as a snapshot.) 

If time code is not running, the Create Marker dialogue appears, allowing you

to create a marker and specify a name and a time. Markers can be viewed in

the Cue List and Graphic Editing windows.



Solo Pre
Lights to indicate a channel is soloed. 

Click to select Solo PFL, AFL, or Solo In Place.

Back Up
Click to turn on automatic Back Up feature. 

Back Up automatically saves the mix to disk every time that time code is

stopped, (if a change has been made). 

Mixes are automatically re-named with an upcounting extension number, for

example, mix.1, mix.2, mix.3, etc.

WWW
This button is a shortcut to launch your web browser. The first time you click

it a dialogue box opens to allow you to select your web browser.  This is

useful to go to our web page to check for updates, operating tips, contacting

technical support and other helpful information.

Locate
Sends an MMC Locate command to machines that respond to MMC. The

Locate Time is entered in the Locate Time field to the left of the Locate

button.

Alternately, a Locate time can be selected from the Locate Snapshots and

Markers Menu, which automatically lists all the snapshots and markers within

the mix.

Locates can be automatically adjusted with a Pre Roll time specified by you in

the Machine Control Preferences.

A. Play
When turned on, causes machines controlled by MIDI Machine Control to

automatically go into play after they have arrived at a locate point.

(Important: For MMC autolocation to work correctly, both the MIDI In and

the MIDI Out of the machine must be connected to your Macintosh MIDI

interface. Remember, your DA7 MIDI interface is in use by MAX, so it is

inoperative for this purpose.)

Locate Time Field
Enter a locate time here. It is sent via MIDI Machine Control the next time

your click on Locate.

1 2
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MAX Control Bar

Locate (Snapshots and Markers) Menu
Allows you to quickly locate and initiate playback from specific points within

the mix. This pop up menu contains a list of all the snapshots and markers in

the current mix.

Selecting a snapshot or marker from this menu causes its time to appear in

the Locate Point field.

Click on the Locate button to send the locate.

Transports
MIDI Machine Control Rewind, Fast Forward, Stop, Play, and Record.

Click on the Transport Buttons send MMC to a connected MIDI interface. 

Overwrite...
Opens the Overwrite dialogue box. This dialogue box is similar to the mixer’s

Automation Setup Overwrite section. It allows you to select which parameters

within the mixer can be edited in real time during the next automation pass.

When Trim has been selected in the Real Time Edit Mode menu (below), only

Faders and Channel Ons can be selected in the Overwrite dialogue box. The

other parameters are dimmed.

Real Time Edit Mode
Select the Edit Mode, either Write, Trim, Read, Manual.

An Edit Mode is chosen prior to selecting individual channels for editing.

Selected channels switch from their current mode (usually Read) into the Edit

Mode.

Memory Meters 
The top Memory Meter is called “Total Memory Used”. It shows how much of

the application’s available memory is being used by the open mixes, undo

buffers, and the clipboard.

The bottom Memory Meter is called “Memory This Mix”. 

It shows how much of the available memory is being used by the currently

active mix, the mix in the front most window.



SMPTE Time Code Display
Displays currently received time code in hours, minutes, seconds, and frames.

When time code reception stops, the SMPTE Time Code display holds the

value of the last time code received, in dim numbers.

T.C.
Click to turn on. Button is yellow when on.

Enables Time Code reception. Time code reception must be turned on for an

automated mix to play back. Turn time code reception off when you do not

want incoming time code to cause a mix to play back.

Frame Rate
Displays the frame rate of the currently received time code.

It is important to manually set the frame rate. Select Preferences in the Edit

Menu to open the Preferences dialogue box. Click to select the Time Code

tab. Click to select the frame rate that you are using for the current project.

If you select an incorrect time code (or one that doesn't match the incoming

time code), MAX may not function properly.  This could result in automated

moves occurring at the wrong time, or even the loss of data.  Please check this

setting before each new mix.

1 4
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Chapter  4

CUSTOM VIEWS
When you launch the application, you will see on your Macintosh what is

called the Custom View screen. The Custom View is MAX's most important

viewing screen. It contains all the key information you need about the

currently selected automated mix, including fader and knob positions,

channel on/offs, time code, and more. 

The Custom View screen can display up to 96 modules. These can be fader

modules, EQ modules, etc.  This screen can accommodate any combination of

modules that you wish to view for the mix you are working on. 

The modules are arranged in 3 rows of up to 32 modules each.

The Custom View screens are important because they allow you to decide

what modules are visible at any given time, and permits you to arrange the

position of modules in any manner.

Custom View 1 shows Channels numbered 1 through 32, Aux Send 1 through

6, Aux Return 1 through 6, Bus 1 through 8, and Master LR.

When two mixers are connected, Custom View 1 shows inputs 1 through 64,

Aux Send 1 through 6, Aux Return 1 through 12, Bus 1 through 8, and Master

LR.



Some Custom Views have been purposefully left blank for you to design.

There are a total of 10 different Custom Views to work with. Look through

them by pressing the left and right arrows on the Macintosh keyboard to

quickly change to the next or previous view.

Alternately, select the Custom View screens from the Windows menu, or you

can use their Command key equivalents.

Though there are 10 different Custom View screens, there is really only one

window per mix. That window can display  any one of 10 different Custom

Views, or the Graphic View, or the Cue List.

1 6
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Custom View

You may open more than one mix at a time. 

Each mix has its own window. 

When more than one mix is open, only the mix in the top most window will

play back when time code is received.

When a Custom View is in the background, the faders, knobs, and time code

will not be displayed.

Many of the Custom Views are already setup, to give you a useful

representation of the various automatable parameters of your mixer. It is

advised that you familiarize yourself with the existing Custom Views, before

beginning to edit them.



EDITING THE CUSTOM VIEWS

Editing the Custom Views may help make certain projects easier to work with.

You can make the view display as little or as much information as you need.

You might be working on a post production project with only four channels

of audio. You could create a Custom View with only four channels. This is

easy to look at and work with.

You could be using MAX to turn your mixer into a control surface for a hard

disk recorder. You could create a Custom View with only 8 faders for that

purpose.
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Before editing the Custom Views, it is recommended that you consider the

feature as an aid to simplifying the mixing process. 

This is especially true if you begin to explore the potential of the Edit Module

begin creating new modules. 

It is better to approach the design of Custom Views and Modules with the

intent of making views with less information, or rather, only information

needed for the mix. It is possible to use these editing features to add

unneeded complexity to the software’s user interface.

There are two ways to edit a Custom View.

To quickly change a Custom View, on a row by row basis, use the Edit

Custom Views dialogue in the Edit menu.

To change the Custom View on a module per module basis, use the Selection

Pop-up Menu accessed by clicking on the lower right of each module.

These are described on the following pages.
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ABOUT THE EDIT CUSTOM VIEWS DIALOGUE

This dialogue box  allows you to name your Custom Views and arrange them

by row. 

The View menu is used to select the Custom View.

The View Name allows you to name the View. Changes made to the View

Name appear in the View Menu, in the Windows menu, and also in the title

bar of the view.

A Custom View has 3 rows of modules.

For each row of modules you may pick the starting channel number, that is,

the left most channel.

You may also select the module type for that row.

(You may later, within the Custom View itself, select the module type on a per

module basis.)

Checking “Apply to New Mixes” saves this configuration as a Preference.

Future New mixes will use the current settings in the Custom View.

If “Apply to New Mixes” is not checked, then the current settings in the

Custom View will apply to only the mix are you editing. New mixes will open

with the default original views.
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SELECTION POP-UP MENU

MAX allows you to redefine the arrangement and function of the modules in

the Custom View. There is a little triangle pointing down under each module.

Clicking on this triangle opens the Selection pop-up menu. 

Channel
Select Channel to change the channel of the module occupying this position.

Channel Names (entered and edited in the Names and Labels dialogue in the

Edit Menu) are displayed in the Channel Selection sub menu.

Group Master
If any channels have been turned into SoftGroup masters, they can also be

selected in this pop-up menu and placed within the Custom View.

Grand Master
Select Grand Master to make the mixer’s Stereo Grand Master appear.

Hint: 

• You can Shift-double click on a module to quickly place the Stereo

Grand Master.
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MIDI
Audio faders can be turned into MIDI faders by selecting MIDI and a

Controller number from the sub menu.

If MIDI faders already exist, they can be selected and placed within the

Custom View.

Module
Select Module to change the module currently occupying the position in the

Custom View.

Selecting New Module opens the Edit Module dialogue, discussed in a later

chapter.

Not used makes the module go away and inserts a “blank panel” in the

Custom View.

Hint: 

• You can also make a blank module appear by single clicking to highlight the 

channel number below the module, and typing delete and then enter.

Between the two dividing lines are pre-defined modules that comprise MAX’s

“Module Library”.

Below the dividing line is a list of any modules that the user may have created

or edited.

Comment
Each channel may have a comment. Open the comment window by selecting

comment from the selection menu. The comment may be up to 255

characters long.

Solo Safe
When you Solo a channel, any number of “Solo Safe” channels will also go

into solo at the same time automatically. When the channel is un-soloed, the

Solo Safe channels will also un-solo. Channel is Solo Safed when this item is

checked. 
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STANDARD FADER MODULE DESCRIPTION

SoftGroup Member Indicator
If the fader is a member of a SoftGroup, the SoftGroup master

fader number is displayed here. 

The indicator is color-coded to help you locate the SoftGroup

master.

Mode Indicator 
This shows the edit mode of the channel; 

Read, Write, Manual or Trim. 

Channel On/Off Buttons
Turns red when the channel is on.

Fader 
Represents the audio level of the channel.

If the fader is a SoftGroup master, the fader turns amber.

If the fader is turned into a MIDI controller, the fader turns blue.

Channel Labels 
You may type a short label (up to 4 letters) underneath each

fader. After clicking to select a fader label, you can tab to the

next text field without pressing the Return or Enter key.

Labels may also be edited in the Channel Names and Labels

dialogue in the Edit menu.

Selection Pop-up Menu
Clicking on the small, downward pointing triangle opens a pop

up menu. The menu allows you to select the audio channel

number, module type, display Group or MIDI faders, and more.

The Selection pop-up menu also allows you to Solo Safe

individual channels, and open a Comment text window.

Channel Numbers 
The number under the fader corresponds to the number of the

mixer’s channel.

The channel numbers may be arranged in any order. 

The channel numbers may be changed either from the Selection

menu, or by typing a new number here.



More About Faders

The basic audio fader module has certain special characteristics,

which you should become familiar with. When a long or short

throw fader is controlling audio (and not MIDI), there may be

one or two fader “knobs” shown for each channel.

Level Fader 
This shows the true audio level of a channel at any moment.

This is the fader that automatically moves during playback. 

Phantom Fader 
When time code is being received, and the mix is playing back,

the Phantom fader shows the position of the real, “hardware”

fader on the mixer. 

The Phantom appears when the position of the fader on the

mixer is different than the true audio level. When the two are in

agreement, the Phantom is concealed and the fader is said to be

“nulled”. 

When performing an Auto Punch Out, the Phantom indicates the

level of the channel on the previous pass.

Trim Reference Point 
When in Trim mode, this small yellow arrow indicates the

starting position of the hardware fader. When the Phantom

Fader is raised above this point, level is added to the original

fader moves. 

When the Phantom Fader is lowered below this point, level is

subtracted from the original fader moves. When the Phantom

Fader lines up with this point, there is no modification of the

original moves.
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GETTING INFO ABOUT A CONTROL

It is sometimes helpful to find out specific information about a control

displayed in the Custom View. 

For example, you may wish to know a control’s exact value.

In addition, if you have designed or edited the module yourself using the

module editor, you may wish to confirm that the control is assigned to the

intended mixer function.

To get info about a control, position the pointer over the control. Hold down

the Macintosh Control key while clicking on the control.

A small pop-up window will display the control’s function, channel, and

current value.

The pop-up window will also show if the control is not connected to the

mixer.

Hint:

• Infinity (∞) on the window may be displayed different, depending on

the Operating  System being used.
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Chapter  5

INTRODUCTION TO AUTOMATED
MIXING IN REAL TIME

This section introduces important concepts relating to writing and editing

fader moves, channel on/offs, and other automated mix events in Real Time

(that is, while the program material is playing, and time code is being

received.) This is the most natural way to mix, because you are mixing while

actually listening to the program material (that is, the music or dialogue).

Later sections of this manual discuss mixing and editing “Off Line”. The term

Off Line is used, as opposed to Real Time, because neither program material

nor time code has to be present in order to mix.

Real Time mixing is primarily done using the Custom Views.

Off Line mixing is primarily done using either the Cue List or the Graphic

View.

BUILDING A MIX IN MANY “PASSES”

This brief section is for those who are not that familiar with how mix

automation is generally used.

Those familiar with mix automation can simply skip this section and proceed

to the section entitled, “Preparing to Write an Automated Mix”.

The first immediate need for an automated mixing system becomes apparent

as soon as a mix becomes complicated from a technical standpoint.

For example, suppose you need to bring up two faders, and at the same time

rotate a pan pot located several feet from the faders.

Those who are familiar with automated mixing know that this is very easy to

do.

You simply play the program material. (That is, whatever you are mixing;

tape, disk, song, soundtrack, etc.) 

Move the mixer’s faders, and the automation system records the fact that the

faders were moved. Rewind the program material. Play the program material

again, and turn the pan pot. 



The automation system records the fact that the knob was turned. Rewind the

program material. The next time you play the program material, the fader

levels and pan position change together. You performed the mix, but the

computer helped you do more than you could by yourself. 

The important concept to be aware of is that the mix is built in several

“passes”: 

Rewinding, playing, mixing and editing the mix, rewinding, etc., until you

have perefcted your mix.

By the time you are finishing the mix, the computer is able to change more

things on the mixer simultaneously and more accurately than you could do by

yourself.

(In addition, automated mixing provides the obvious advantage of using a

computer to save the mix data to disk, edit the mixes, and more.)

Note:

When using MAX, certain functions of the DA7 become redundant or not

applicable.  Therefore, MAX mix data will not be affected if you perform any

of the following operations.

• MAX will not save changes made using the Multi-Channel View function

on the DA7 mixer.

• Recalling a Scene memory or a Library on the DA7 mixer

• Using the "UNDO" key on the DA7 mixer 

To match the relationship between the DA7 mixer and the MAX screen,

execute Update Configuration in the Real Time menu of the MAX. Unmatched

status may occur after the following operations.

•  Any of Surround Mode, the function of Dynamics or the filter type of

Equalizer is changed.

• UNDO is operated on the DA7.

• Data settings are copied from one channel to another while displaying

Multi Channel View on the DA7. 

• A Scene memory or a Library is recalled on the DA7.
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PREPARING TO WRITE AN AUTOMATED MIX

When preparing to write an automated mix, (that is to say, perform a mix

“pass”), you first need to decide three things:

(1) What kind of mix parameters do you wish to be written
during this pass?

For example, you might decide to write and edit only faders, or channel

on/offs only, or EQ only. 

Or you might decide you want every change you make to the mix to be

written.

(2) What kind of edit are you going to perform? 
For example, suppose you have already written some fader “moves”. On the

next pass, you may want to edit those fader moves. 

You can edit them in “Write Mode”. This means that the new fader moves will

erase and replace the previously written fader moves. 

Or you can edit them in “Trim Mode”. This means that the new fader moves

will not erase but rather modify the previously written fader moves. While

much more will be explained in a following section about the various edit

modes, including Write and Trim, suffice it to say for now that you can chose

for each pass what kind of edit to perform.

(3) Which audio channels do you wish to be written during
this pass?

For example, you might decide to write only faders 1 and 12 on one pass. On

another pass, you might want to be able to write all the faders.
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SETTING WHICH PARAMETERS ARE OVERWRITE ENABLED

In a given pass, you may decide to edit some parameters and not others. 

The mixer allows automation of Faders, Channel On/Off, EQ, Aux, Pan,

Dynamics On/Off, and Routing.

These parameters must be individually Overwrite Enabled prior to writing an

automated mix.

Click on the Overwrite button in the Control Bar.

Or, select Overwrite... from the Real Time menu.

This opens the Overwrite dialogue box.

Enable each parameter that you intend to edit in the next pass.

Parameter that are not enabled will be “read only” in the next pass. That is,

they will play back any previously written moves, but will ignore new moves.

CHOOSING THE EDIT MODE

There are four edit modes, Write, Trim, Read and Manual.

The software features a Edit Mode menu in the Control Bar. 

Select the Edit Mode from the menu, or type w, t, r, or m. 

After selecting the Edit Mode, use the individual Select buttons above the

fader on each mixer channel to set the mode on a channel per channel basis.

Always take note of your current Edit Mode Menu choice.

When a channel is selected, it will go into the Edit Mode shown in the Edit

Mode menu.

When not selected, a channel will be in Read mode.
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EDIT MODES (READ, WRITE, MANUAL, & TRIM) DEFINED

Generally speaking, getting MAX to remember your automated mix is called

“Writing” an automated mix.

When MAX is playing back the automated mix it is called “Reading” the mix. 

Its possible to play the program material and mix without having the

computer remember your moves. This is called “Manual” mixing. 

After an automated fader or channel on/off has been written, there are two

main ways to edit them while the mix is playing. The fader or channel on/off

can be edited by Writing it again. 

Or, the already written move can be changed or “trimmed”.

Write Mode means you simply write them again, which erases and replaces

any previously written moves on that channel. 

Trim Mode does not erase and replace automation moves, rather it modifies

the moves previously made. For example, a fader in trim will play back

previously written moves, while you are allowed to shift those moves up or

down. 

While more will be said about these modes shortly, the main point of this

discussion is to say that an audio channel can be in one of four different

modes: Write, Trim, Read, or Manual.
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Write Mode
When the Edit Mode menu indicates WRITE, selecting channels puts them

into Write mode.

Channels in Write are “armed” and ready to write automation moves.

Select Write Mode from the Edit Mode menu by typing “w”.

Trim Mode
When the Edit Mode menu indicates TRIM, selecting channels puts them into

Trim mode.

Channels in Trim are “armed” and ready to Trim automation moves.

In Trim mode, fader moves that you have previously written will not replaced. 

The moves will be left intact but the overall level will be relatively “offset”. 

For example, say that you have made some very complicated fader moves

while riding a vocal track, on a fader in Write mode. 

You roll back the program material to hear what you’ve done, and you like

the results, but you just wish that the whole track were a bit softer. 

Trim mode allows you to shift up or down the level by adding or subtracting

from the fader moves already entered, without having to re-write all the

moves. 

Trim mode is also used for editing channel on/offs and other switch events.

When a switch is pressed while the channel is in Trim mode, additional switch

events are only added to the previous events, without replacing previously

written events.

Select Trim Mode from the Edit Mode menu by typing “t”.

Read Mode
When the Edit Mode menu indicates READ, selecting channels puts them into

Read mode.

Channels in Read only play back previously written moves. 

Select Read Mode from the Edit Mode menu by typing “R”.

This also de-selects all channels as if you drag down the Disable All in the Real

Time Menu. For more information see page 203, Enable All/ Disable All. 
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Manual Mode
When the Edit Mode menu indicates MANUAL, selecting channels puts them

into Manual mode.

Moving the faders will change the sound of the mix, but the changes will not

be written or saved.

De-selected channels go into Read. At the moment they are de-selected, they

will snap to their last automated level, and then play back any previously

written fader moves.

To de-select a channel, press the select button above each individual fader

that you want to return to read.

Select Manual Mode from the Edit Mode menu by typing “m”.

This also selects all channels as if you drag down the Enable All in the Real

Time Menu. For more information see page 203, Enable All/ Disable All.

SELECTING THE MIXER CHANNELS YOU WANT TO EDIT

After choosing the Edit Mode from the software’s Edit Mode menu, there are

three different ways to select a channel.

Press the Select Button above the fader. 

— or —

Use the mouse to click on the Mode indicator in the fader

module within the Custom View. 

— or —

Turn SoftTouch™ on. 

When SoftTouch is on, the fader is automatically selected when

it is moved. 

Hint

• You can select the channels directly on the DA7 mixer, or on MAX

while you are using the Edit Mode.

·  First, press the MMC/CURSOR key so that the DA7 enters the MMC

mode ("MMC" appears in the lower right hand corner of the screen

located on the DA7). 

·  Then, press the SELECT LED button of the channels you want to

edit, while holding down "0" key of the 10 KeyPad.
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Chapter  6

MAX REAL TIME OPERATION
OVERVIEW OF FIRST AUTOMATION PASS

These are very basic instructions for starting a new mix session. 

s Turn Receive Time Code Off.

s Play the program material. Decide how you want the faders and
channel on/offs to be initially set.

s Turn Receive Time Code On.

s Enable Fader and Channel On Overwrite.

s Set Edit Mode menu to Write.

sClear Memory.

s Play program material.

s Select the Channels that you wish to Write.

s Perform a mix, then stop the program material.

s Save the mix.

sRewind the program material.

s Listen to the mix, determine what additional edits need to be done.

The following pages provide more details.



FIRST AUTOMATION PASS IN DETAIL

Preparing to Mix

▼ Turn Receive Time Code Off.
Receive Time Code is turned on and off by clicking on the T.C. button in the

Control Bar.

This allows you to freely move faders and listen to the mix. The MAX will

neither write nor read moves.

When beginning a new session, turning Receive Time Code Off is easier than

using Manual mode, because it makes the Edit Mode irrelevant. Also, when no

time code is being received, you can more freely explore the software, label

tracks, etc.

▼ Play the program material and decide how you want the faders and

channel on/offs to be initially set.
For example, say that the program material begins with a few bars of an all-

percussion intro on tracks 1 through 7. You may want the mix to begin the

remaining tracks off. Move faders 1 through 7 to balance the percussion

tracks. Turn off the remaining tracks using the mixer’s Channel On/Off

buttons. 

As long as Receive Time Code is Off, no moves have been written yet. 

Once you have found a comfortable starting condition for the mix, stop the

program material and rewind it to a point a little before the beginning of the

song or score.

We are rewinding the program material for the sake of making a simple

example.

Actually, MAX lets you start and end an automation pass anywhere in the

song. 

Only the very first pass in a mix should start at the beginning.

You’ll never have to specify start and end times, you may construct the mix in

as many passes as you please, and you are never required to let the song play

all the way through on any pass.
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▼ Turn Receive Time Code On.

Receive Time Code is turned on and off by

clicking on the T.C. button in the Control Bar.

▼ Enable Fader and Channel On Overwrite.

Click on the Overwrite button to confirm

settings. 

Fader and Channel On are already automatically

pre-selected on your first pass of a new mix.

▼ Set Edit Mode menu to Write.
If the Edit Mode menu does not already indicate

Write, type the letter “w”.

▼ Clear Memory.
Select Clear [Untitled-1] from the Edit menu. 

Obviously if you have just launched MAX, (or

selected New from the File menu), there is

nothing written yet and nothing to Clear. 

It is still a good practice to Clear when you start a

new mix, just in case while experimenting with

the system you have accidentally or intentionally

written some meaningless fader moves.

After selecting Clear you are ready to start a new

mix. 
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Clearing Memory Arms MAX to Capture One Initial “Snapshot”.
The MAX is a “dynamic” automation system, meaning that fader

movements are written only when a fader is moved, and that these

movements are recorded with respect to time code. 

MAX also automatically captures one “snapshot”. 

A snapshot is a picture stored in the automation memory. 

It contains the starting position of all the faders, and the on / off condition of

all the channels, and all other automated mixer parameters.

On the first pass of a new mix, after a Clear, MAX scans the mixer, capturing

the initial conditions into the mix memory as a snapshot. 

That way, whenever you rewind the program material and restart it from the

beginning, MAX can quickly restore the correct initial conditions before the

song begins.

You can edit this snapshot later on. The important point here is that this one

snapshot is captured automatically on the first pass. The snapshot is taken at

the moment the first fader move is made, when time code is received after

you have cleared the memory.

▼ Play the Program material.
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Select the Channels that you wish to write.

As stated previously, you can select channels with the mixer’s Select button.

Or, you can use the mouse to click on the Mode indicator. 

If you are writing faders, you may also use SoftTouch to automatically select

the channels.

When writing faders, multiple channels can be selected. 

You can write as many faders as you wish in a given pass, when you are

writing faders only, or faders and channel ons only.

Type Command E (Enable all) to select all faders and put them into write

mode.

This “Selects” or arms all the faders at once. 

Selecting all the faders at once is usually only done on the first few passes.

When writing channel ons, it is actually not necessary to Select a

channel.

Using the DA7's On buttons, Channel Ons can be written on any channel.

When writing any other parameters, (pan, routing, surround, dynamics,

EQ, etc.), you can select only one channel at a time.

Perform a mix.

You may write fader moves or channel on/offs in any order, and in as many

“passes” as you wish, but for sake of simplicity we suggest laying down

channel on/offs on the first pass. It is not necessary to let the whole song play

through on any pass.

Writing Channel On/Offs
Perform your channel on/offs on the mixer using the channel on/off buttons. 



Stop the program material at the end of the pass. If you have more channel

on/off moves to make on other channels, rewind and restart the program

material to add more channel on/offs. 

Writing Faders 
Move the mixer’s faders. In a previous step we Selected all the faders. As long

as time code is being received and the mode indicator above each fader says

Write, fader moves are being written.

Stop the program material at any time.

Save the mix. Type Command S and give the mix a name.

Stop the program material at any time.

Save the mix. Type Command S and give the mix a name.

Rewind the program material, play it and listen.

Writing Additional Snapshots
To capture additional Snapshots in real time, Capture Snapshot (Command ,)

while time code is being received.
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More About Snapshots
MAX automatically takes one snapshot on the first pass after clearing memory.

The snapshot time is equal to the first time code received. The snapshot is

only taken if some new move is made. Do not write moves before the first

snapshots, since MAX will reset the mixer to the recorded snapshot settings

once it passes the start time-code location.

Writing Routing
Routing is accessed on the mixer by pressing Routing in the Configuration

section. 

(Surround panning is also accessed by pressing Routing, however, this is

covered in more details in a later section of the manual.)

First click on the Overwrite button (or select Overwrite from the Real Time

menu), and enable Routing editing by clicking on the button next to the word

Routing.

When starting a new mix (that is, the memory has been cleared), the current

routing condition will be automatically saved in a “Snapshot” when the first

pass is written.

Select Write from the Edit Mode menu. 

Write Enable the individual channel, using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

turn on and off the desired bus, or Master LR assignments.

(If you later wish to edit routing Off Line, changes to routing will appear as

“bus assign” on and off events in the Cue List. New routings are created using

the Create Switch Events dialogue box.)

Writing Aux Sends
Aux Sends are accessed on the mixer by pressing any of the 6 Aux buttons in

the Mixing section. 

First click on the Overwrite button (or select Overwrite from the Real Time

menu), and enable Aux editing by clicking on the button next to the word

Aux.

Routing Button

Aux Button



When starting a new mix (that is, the memory has been cleared), the current

Aux send levels and pre/post selections will be automatically saved in a

“Snapshot” when the first pass is written.

Select Write from the Edit Mode menu. Write Enable the individual channel,

using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

adjust Send Levels and change the Pre/Post switches if desired.

(If you later wish to edit the Aux Sends Off Line, changes to the Aux Send

Levels may be made using the Create Parameter Change dialogue box.

Changes to the state of the Pre/Post switches are made using the Create

Switch Events dialogue box.)

Note: Switching AUX Send On/Offs automatically creates an event in the Cue

List, but this event will not affect the mix data.

Writing Pans
Pan control is accessed on the mixer by pressing Pan in the Configuration

section. 

Click on the Overwrite button (or select Overwrite from the Real Time menu),

and enable Pan editing by clicking on the button next to the word Pan.

When starting a new mix (that is, the memory has been cleared), the current

Pan positions will be automatically saved in a “Snapshot” when the first pass is

written.

Select Write from the Edit Mode menu. Write Enable the individual channel,

using the mixer’s Select buttons (Enable both channels if these are engaged in

a “GANG").

Start the program material or other source of time code, and use the mixer to

adjust the Pans.

(If you later wish to edit the Pans Off Line, changes to the Pans may be made

using the Create Parameter Change dialogue box.) 

Writing EQ
EQ adjust is accessed on the mixer by pressing EQ in the Configuration

section. 

Click on the Overwrite button (or select Overwrite from the Real Time menu),

and enable EQ editing by clicking on the button next to the word EQ.
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When starting a new mix (that is, the memory has been cleared), the current

EQ settings will be automatically saved in a “Snapshot” when the first pass is

written.

Select Write from the Edit Mode menu. 

Write Enable the individual channel, using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

adjust the EQ section.

(If you later wish to edit the EQ Off Line, changes to the EQ knobs (such as

frequency, gain, etc. may be made using the Create Parameter Change

dialogue box. Changes to the state of the EQ in/out switches are made using

the Create Switch Events dialogue box.)

Writing Gain and Phase
Gain is accessed on the mixer by pressing Gain in the Configuration section. 

Click on the Overwrite button (or select Overwrite from the Real Time menu),

and enable gain editing by clicking on the button next to the word Gain .

When starting a new mix (that is, the memory has been cleared), the current

gain settings will be automatically saved in a “Snapshot” when the first pass is

written.

Select Write from the Edit Mode menu. 

Write Enable the individual channel, using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

adjust gain and phase.

(If you later wish to edit the gain and phase, changes to the gain may be made

using the Create Parameter Change dialogue box. Changes to the state phase

switches are made using the Create Switch Events dialogue box.)
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Writing Delay
Delay is accessed on the mixer by pressing Delay in the Configuration section. 

Click on the Overwrite button (or select Overwrite from the Real Time menu),

and enable Delay editing by clicking on the button next to the word Delay.

When starting a new mix (that is, the memory has been cleared), the current

Delay settings will be automatically saved in a “Snapshot” when the first pass

is written.

Select Write from the Edit Mode menu. 

Write Enable the individual channel, using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

adjust the Delay settings.

(If you later wish to edit Delay Off Line, changes to the Delay Time may be

made using the Create Parameter Change dialogue box. Changes to the state

of the Delay on/off switches are made using the Create Switch Events dialogue

box.)

Writing Dynamics
Dynamics are accessed on the mixer by pressing Dynamics in the

Configuration section. 

Click on the Overwrite button (or select Overwrite from the Real Time menu),

and enable Dynamics editing by clicking on the button next to the word

Dynamics.

When starting a new mix (that is, the memory has been cleared), the current

Dynamics settings will be automatically saved in a “Snapshot” when the first

pass is written.

Select Write from the Edit Mode menu. Write Enable the individual channel,

using the mixer’s Select buttons.

Start the program material or other source of time code, and use the mixer to

adjust the Dynamics settings.

Delay Button

Dynamics Button



(If you later wish to edit Dynamics Off Line, changes to all of the variable

Dynamics parameters (knee, threshold, etc.) may be made using the Create

Parameter Change dialogue box. Changes to the state of the Delay on/off

switches are made using the Create Switch Events dialogue box.) 

Note: Before writing Dynamics in a mix, you need first to create Dynamics

Libraries into DA7’s memory with such parameters as threshold, etc.

Second, start a new mix as described this section.

Third, open “Create Library Events” window from Off Line menu to select a

library previously stored and to set the time that the Library Event starts.

Also you can change assignments for Start Time, Event, etc., in the “Cue List”

window if stored beforehand.

FADER EDITING

You now know how to write a first pass of fader moves and see them play

back. 

After your first pass, there are a few more things to consider in creating a

good automated mix. 

Since you will be constructing your mix in multiple passes, starting and

stopping anywhere in the song, it is important to take advantage of MAX’s

ability to allow seamless fader edits.

This section introduces important concepts relating to editing fader moves

and channel on/offs in Real Time (that is, while time code is being received.)

Notes:

• On the mixer, do not operate faders and the JogDial at the same time. 

• On the MAX window of your Macintosh, channel faders assigned in Stereo

may move inaccurately at times. Even if this occurs, the stored mix data will

be unaffected.
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The Phantom Faders

When MAX is locked to time code and automating the mixer, every fader

move that you made in Write Mode is being “played back”. 

If the “MOTORS” button is turned off, the physical faders on the mixer will

not move, but the audio levels are changing nonetheless because the faders

on the Macintosh monitor are moving. The real faders on the mixer are

simply resting in the last position that you left them at. 

As an example, while playing back an automated mix, MAX may have been

programmed to turn the audio level down on a certain channel. But the real

fader on the mixer has been left “full on” from a previous pass. 

Suppose that you were to put the channel into Write mode now, to do a re-

write of the fader move. As soon as you moved the fader on the mixer a little

bit, the gain of the channel would “jump up” to meet the fader. 

If the mixer motors are turned off (with MAX’s “Motors” button), much of the

time during mixing, the physical position of a fader will have no relationship

to the actual level of the channel, which will continually vary according to the

mix you have written. 

In addition, even if the motors are on, there are times when you can be

manually moving a fader to a position other than the actual automated audio

level.

“Phantom Faders” are provided to assist you in keeping track of the real

position of the faders on the mixer, with respect to the position of the

moving, automated fader. Phantom Faders on the computer indicate the

position of the real (hardware) faders on the mixer. 
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In addition, even if the motors are on, there are times when

you can be manually moving a fader to a position other than

the actual automated audio level.

Note: Phantom faders are operative only from the DA7 mixer.

What is a Null Point?

When MAX is receiving time code, and an automated mix is

playing back, the faders on the computer monitor are moving.

As stated previously, there can be times when the position of

the fader on the mixer is different than the actual audio level as

indicated on the computer.

To move a fader to its “null point” means to manually move a

fader on the mixer until it matches (that is, lines up with) the

position of the fader on the computer.

Manually Nulling a Fader

When the mixer is receiving time code, slide the fader (down

or up) just to the position where the Phantom Fader lies under

the Level Fader. When the two faders are superimposed, the

fader is said to be “at its null point”, or simply “the fader is

nulled”. 

You can now put the fader into Write mode to re-write the

fader moves, without any jump in level. 

When the fader is writing, the Phantom disappears. 

When time code is not being received (because either the

program material is stopped or Receive Time Code menu item

is unchecked), the faders are always “live”, and no Phantoms

are seen.

Phantom Faders appear as you move the faders when time

code is being received. The Phantoms will automatically

disappear after about 8 seconds if you are not moving the

faders.

Example:
Fader 1 on the
mixer must be

moved up to null
the fader.



Manually Punching In Fader Moves

In Write Mode you may selectively rewrite (that is, replace) any fader moves in

any part of the mix. 

Simply fast wind the program material to a place a few seconds before the

fader moves that you wish to replace. 

Make sure that faders are Overwrite Enabled.

Check that the Edit Mode is set to Write.

Start the program material, and use the Select button to toggle the fader from

Read to Write.

If motors are turned off (using the Motors button), use the Phantom Faders to

help you find what the actual channel level is at that point in the mix. 

Slide the fader down or up just until the two faders are nulled. Now the

position of the fader accurately reflects the level of the channel. Then put any

number of faders into Write mode by Selecting them, and make the new

moves.

Two Ways to Manually Write Enable a Fader

Normally, a fader is put into Write by using its Select button.

The fader move is not written until fader is moved.

Alternately, you can put the fader into Write with the mouse by clicking on

the Mode indicator in the fader module.

This action immediately writes the current fader position, without having to

move the fader.

Note: When recording fader moves of a Link group, make sure to set the

individual channel mode to WRITE for both channels assigned to the

group. 
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Auto Punch In and Auto Punch Out 

Auto Punch In and Out make editing easier by automatically switching any

selected fader from Read into Write mode when the fader is moved across its

null point. 

Auto Punch In lets you arm the fader before writing fader moves. You do not

have to bother about null points or jumps in level. The fader will not actually

start writing moves until you move it to its null point, the level of the channel

from the previous pass.

Likewise, Auto Punch Out lets you arm the fader in advance of switching to

read. You do not have to bother about null points or jumps in level. The fader

will not stop writing moves until you move it to its null point, the level of the

channel on the previous pass.

Thus smooth and seamless fader edits may be made without any jumps in

level.

Turn on Auto Punch In by selecting it from the Real Time menu.

(Clicking on the AUTO button in the Control Bar turns on both Auto

Punch In and Auto Punch Out. To keep things simple, for now just turn on

only Auto Punch In from the Real Time menu. That way you have the

opportunity to learn how they work separately.)
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Using Auto Punch In and Write Mode
Check that the Edit Mode menu is set to “Write”.

The individual channel mode indicators above each fader should say READ.

To re-write only specific channels, press the individual channel’s SEL
Buttons. The individual channel mode indicators flash from Read to Write, alerting

you that the track is armed for writing.

Slowly move the fader. This fader movement is not written into memory yet.

The channel status will automatically “Punch In”, changing from a flashing

condition to WRITE as the fader is moved slowly across its null point. The

Phantom will disappear.

Some engineers prefer to think of it as reaching with the Phantom to “grab”

the level fader.

The fader will only Punch In if it is moved slowly.

The software behaves this way to avoid an unintentional Punch In, should you

accidentally bump a fader.

The fader is now in Write mode and the move is being written into memory,

replacing any previous moves during this time period.

To manually “Punch Out”, that is, to return the fader to Read, press the

channel’s SEL Buttons.

When the fader returns to Read, it will begin playing back any previously

written fader moves.
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Using Auto Punch In and Read Mode
Auto Punch In and Read Mode may be used together to “rehearse” a fader

move.

Remember that in Read, the mix is playing back.

Selecting a fader in Read switches the fader into Manual. That means that the

fader is affecting the audio level, but the fader moves are not being written.

In this scenario, the Edit Mode menu says Read, and most of the faders are in

Read. 

But a few faders have been Selected and are in Manual. This means that you

listen to the mix play back, while moving a few faders in Manual. 

In essence you are rehearsing fader moves, since you can hear what the fader

moves would sound like with respect to the whole mix, though you are not

writing any new fader moves yet.

The procedure for rehearsing a fader move is given on the following page.

5 1

MAX Real Time Operation



How to Rehearse a Fader Move
Check that the Edit Mode menu is set to Read. 

The individual channel mode indicators above each fader should say READ.

To rehearse channels, press the individual channel’s SEL Buttons. The

individual channel mode indicators flash from Read to Manual, altering you

that the track is armed for manual mixing. 

Slowly move the fader. This fader movement will not affect the level yet. The

channel status will automatically “Punch In”, changing from a flashing

condition to Manual as the fader is moved slowly across its null point. The

Phantom will disappear.

The fader will only Punch In if it is moved slowly.

The software behaves this way to avoid an unintentional Punch In, should you

accidentally bump a fader.

The fader is now in Manual mode, allowing you to listen to the move. No new

moves are written into memory.

To manually “Punch Out”, that is, to return the fader to Read, press the

channel’s SEL Buttons. When the fader returns to Read, it will begin playing

back any previously written fader moves.
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Using Auto Punch Out
When Auto Punch Out is turned on, first write your fader moves as described

above.

When you are ready to punch out, press the channel’s SEL Buttons again. The

fader will not instantly return to Read. 

Instead, a Phantom fader appears. This Phantom fader represents the level of

the fader from the previous pass, so it may be a moving Phantom fader. 

(This is the only circumstance when a Phantom does not represent the

physical position of a hardware fader.) 

Slowly move the fader on the mixer. As the fader is moved across its original

null point, the fader will automatically “Punch Out”, changing from Write to

Read mode.

As soon as the fader’s individual channel mode indicator says Read, Phantom

Fader will once again indicate the position of the physical fader. The level

fader will continue to play back any previously written fader moves. 

This results in a seamless punch-out.
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Important Notes About Auto Punch In and Out : Auto Punch Out Does
Not Operate with SoftTouch
Auto Punch Out does not operate in conjunction with SoftTouch (next

section.) This is because SoftTouch continues to write fader moves as long as

you are moving the fader, so the punch out occurs when you stop moving the

fader.

If SoftTouch is turned off, clicking on the AUTO button turns both Auto

Punch In and Auto Punch In on or off.

If SoftTouch is turned on, clicking on the AUTO button will only turn Auto

Punch In on or off.

If AUTO is clicked first, turning on both Auto Punch In and Auto Punch

Out, the TOUCH button will be dimmed.

Auto Punch In and Out are De-selected on First Pass

Auto Punch In and Auto Punch out are special editing modes that are used

after some fader moves have already been written.

To make the MAX software easier to use, Auto Punch In and Out are

temporarily de-selected on the first pass, that is, whenever the memory has

been cleared.

Both Auto Punch In and Auto Punch out require that some fader moves are

already in the mix.

So, even if you have turned on Auto Punch In and Out, on the first pass, when

a fader is Selected, it will immediately go into Write, without flashing an

armed condition.
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SoftTouch™ 

When SoftTouch is turned on, faders on the mixer behave as if they

were touch sensitive, similar to moving fader systems. When the Edit Mode

menu says Write or Trim, simply moving any fader selects it, without pushing

a button. 

There will be no jump in level if Auto Punch In is also turned on,

because the move will not be written until the null point is crossed. 

In Write mode, with both Auto Punch In and SoftTouch turned on, when a

fader is moved the channel mode indicator will flash Read-Write.

The Phantom Fader will appear. Since Auto Punch In is on, the fader move

will not be written until you move the fader to the null point.

The fader will return to Read mode if it is not moved for a certain period of

time. This time period is user-set in the Preferences dialogue box. It is entered

in seconds.

Turn SoftTouch On by clicking on the TOUCH button in the Control Bar.

SoftTouch Time Out 

Open the Preference dialogue box in the Edit menu. Select Faders.

SoftTouch Time Out sets how long it takes after you stop moving the fader for

it return automatically to Read mode.

SoftTouch In Read Mode

When the Edit Mode menu says Read, if SoftTouch is turned on, moving a

fader puts that fader into Manual. Previously written moves will not play back

on that fader, and you have manual control over the fader. The level will jump

to match the position of the fader.

If Auto Punch In is also turned on, there will be no jump in level. Moving the

fader will cause the mode indicator to flash Read-Manual. The fader will go

into Manual when it is moved to the Null point.
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Important Notes About SoftTouch 

A Fader May Occasionally Arm Itself
Since the fader is being “digitized”, that is, its position is being turned into a

number, occasionally the fader will be “resting” between two numbers. This

means that a slight vibration of the fader will be detected as a fader move, and

arm the fader. 

This is because the software is designed to make the faders very responsive to

the engineer’s touch. The MAX System’s software, however, does detect and

reject such minute changes in fader position, but it is possible for one to

occasionally get through. 

Even so, if a fader does arm itself, it should not cause any problem if Auto

Punch In is on. That fader cannot actually write moves to the mix unless the

null point is crossed.

SoftTouch Should be Turned Off During Mixdown
Since SoftTouch selects faders when they are moved, turn SoftTouch off

before mix down. 

Otherwise, any fader accidentally moved while in Read will automatically

switch to Manual mode. If Auto Punch In is turned off, the fader will

immediately become manual and stop playing back previously written fader

moves.

Likewise, any fader accidentally moved while the Edit Mode menu says Write

will automatically switch to Write mode. If Auto Punch In is turned off, the

fader will immediately begin writing and stop playing back previously written

fader moves.

Auto Punch Out Does Not Operate with SoftTouch
Auto Punch Out does not operate in conjunction with SoftTouch (next

section.) This is because SoftTouch continues to Write fader moves as long as

you are moving the fader, so punch out occurs when you stop moving the

fader.

If SoftTouch is turned on, 
clicking on the AUTO button will only turn Auto Punch In on or off.

If AUTO is clicked first, 
turning on both Auto Punch In and Auto Punch Out, the TOUCH button will

be dimmed.

5 6

MAX Real Time Operation



5 7

MAX Real Time Operation

Trimming Fader Moves in Trim Mode

Trim Mode is used for relatively “offsetting” fader moves without actually

replacing them. Any moves made in Trim Mode will be “added to” or

“subtracted from” previously written moves. Thus the subtle nuances of the

original fader move are preserved, only the overall level of the track is raised

or lowered.

(Trim Mode is also used for editing Channel Ons and other switch

events, this is discussed in the following chapter.)

You can Trim the entire mix without playing the program material all the way.

When doing a Trim, if you do not return the Phantom fader to the reference

point, and stop the program material, you have the option of Trimming the

track for the entire mix.

To Trim a channel, once again cue the program material to some place in the

song before the intended edit. 

Determine what the nature of the Trim will be, whether you intend to scale

the level up or down in level. 

If you plan on boosting the level, you may want to start with the fader(s)

below center position. This assures that you have enough “throw” to move

the fader upward. 

Likewise, if you plan on scaling the track down, you may want to move the

fader(s) above center position. 

If you are not sure, then just move the faders to approximately center

position.



Set the Edit Mode menu to Trim, by typing t on the

Macintosh keyboard.

Press the SEL Buttons to set individual channels into Trim

mode.

Start the program material. 

The Level Fader will play back any previously written moves.

The Phantom Fader will not go away as it did in Write Mode,

rather it will still indicate the position of the physical fader. 

A Trim Reference point will appear for each Selected channel

in Trim Mode. This will help you keep track of the starting

position of the physical fader. 

When the Phantom Fader is above the Trim Reference point,

you are increasing the level of previously written moves. 

When the Phantom Fader is below the Trim Reference
point, you are decreasing the level of the previously
written moves.

When the Trim has been completed, move the fader to
align the Phantom with the Trim Reference point. 

To stop Trimming, selecting Read Mode from the Edit Mode

menu. Then, on the individual selected channels, press the

SEL Buttons. Or you may simply stop the program material.
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Trim Until End 

Suppose that while you are Trimming a track, you moved the fader up above

the reference point, to add gain to the track. Then suppose you stopped the

program material, without returning the fader to the reference point.

You may choose whether the Trim will affect that track for the rest of the

song, or whether the track will “snap back” to its previous level.

A dialogue box will automatically appear whenever you stop the program

material without having returned the fader to the reference point. The

dialogue box gives you the option of either Trim Until End or Don’t Trim.

Select Trim Until End to Trim the track all the way to the end of the song.

Select Don’t Trim and the levels of the tracks will snap back to their previous

levels at the end of the Trim.

Whatever is chosen, if No More Warnings is checked, then the current Trim

to End setting will be saved in the Preferences and the dialogue box will not

appear again.
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Trim Until End Preferences

In the Preferences Dialogue box in the Edit Menu, under “Trim Until End”,

check either Always, Never, or Ask First. 

When Always is selected, the Trim Until End dialogue box will not appear at

the end of the pass. The software Trims the track for the entire mix. 

When Never is selected, the Trim Until End dialogue box will not appear at

the end of the pass. For every pass where a Trim is performed, the Trimmed

tracks snap back to their original levels after the Trim. 

(You always have the option of course of turning the Trim dialogue box back

on again by clicking Ask First in the Preferences dialogue box .)

When Ask First is selected, the Trim Until End dialogue box will appear at the

end of the pass as just described, giving you the option with each pass to

either Trim Until End or Don’t Trim.
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Auto Disable

When Auto Disable is checked, Selected faders automatically switch to Read

when the program material is stopped.

This prevents accidental writing of fader moves on the playback of the next

pass.

Auto Disable defaults to On (checked). 

There are some circumstances where it might be desirable to turn Auto

Disable off. 

For example, say that you have chosen to select the faders using the SEL

Buttons. Suppose also that you are looping the program material and

continually re-writing the mix. 

With Auto Disable On, every time the program material stops, the faders

revert to Read. If you are looping, this would require that you to re-select

each fader with each pass.

Under these circumstances, it would be more convenient to leave Auto

Disable Off. That way, Selected faders remain Selected with every pass.

Keep in mind, however, that if a fader stays Selected, you have no opportunity

to null the fader.

When Auto Disable is off, under some circumstances you can “get away with”

editing in Write mode. If the tracks you are editing are silent at the start of the

loop, any jumps in fader level would not be heard.

Generally speaking, editing in Trim would be a better practice than editing in

Write mode, should you choose to turn Auto Disable off.
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CHANNEL ON/OFFS AND SWITCH EDITING

In addition to the Channel On buttons, other mixer switches can be

automated. These include:

• Aux Send 1 through 8 Pre/Post 

• Aux Send 1 through 8 On/Off

• Bus Assign 1 through 8 

• Master Assign 1 through 8

• Direct Out 1 through 8 

• Gang Select On/Off

• Phase

• Delay On/Off

• EQ On/Off

• Dynamics On/Off

Like faders, channel on/offs and other switches may be edited in either Write

or Trim mode.

Write
Replaces previously written channel on/offs or other switches.

Trim
Adds additional Channel On/Offs or other Switch Events.

Examples
Suppose channel 1 is turned on and off every other second, for a whole song.

Save this mix as “Channel On/Off demo 1”. Rewind song to beginning.
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Writing Channel On/Offs
Open “Channel On/Off demo 1”

In Write Mode, start time code.

Press channel 1 on button at 00:00:05:15. 

Stop time code at 10 seconds.

The resultant mix will have channel 1 turn on and off every second up to five

seconds.

At 00:00:05:15, the channel will turn on and stay on. 

It will turn off again at 11 seconds.

After 11 seconds, the on and off every second will resume.

Trimming Channel On/Offs
Open “Channel On/Off demo 1”

In Trim Mode, start time code.

Press channel 1 on button at 00:00:05:15. 

Stop time code at 10 seconds.

The resultant mix will be nearly identical to the original mix “Channel On/Off

demo 1”.

The only difference is that channel 1 will turn on a half second earlier than

00:00:06:00.

(That is, the channel will stay on a half second longer.)

6 3

MAX Real Time Operation



PAN, AUX SENDS, EQ, GAIN AND DELAY EDITING

Pan, Aux Sends, EQ, Gain and Delay are generally controlled by the mixer’s

“rotary encoders”. 

(Though the aux send levels can also be controlled by the faders, there is no

special benefit to doing this as far as the automation is concerned. Aux send

levels are only written on channel at a time.)

Parameters controlled by rotary encoders are very easy to edit, because the

rotary encoders are designed to be “self-nulling”. When you edit a level with a

rotary encoder, rotating the encoder always causes the level change to start

from the current level. This means that the mixer prevents unwanted jumps

in level when the knob is turned.

Pan position, Aux Send levels, EQ settings, Gains and Delay times are edited

in Write mode only, not in Trim like faders and switches.

The procedure for editing (that is, re-writing) these parameters is the same as

the procedure for writing them.

First open the Overwrite dialogue to select the desired parameter or

parameters.

Then, select Write mode from the Edit Mode menu.

Cue up the program material to the place just prior to the edit. Start the

program material.

Then, select the one channel that you wish to edit. Only one channel may be

selected at a time. 

Use either the mixer’s Select buttons, or click on the mode indicator with the

mouse.

Rotate the appropriate encoder on the mixer to make the edit.

Stop the program material at any time. Rewind and listen to determine if

further editing is necessary.
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UNDO A PASS AND ABORTING A PASS

Undo (Command Z)
As you build a mix, each successive pass becomes part of the mix that is held

in the computer’s RAM and may also be saved to disk.

If you do not wish to keep the last pass, you may Undo the pass by typing

Command Z, or selecting Undo from the Edit Menu. 

The Edit Menu will indicate Undo Write at the end of a pass in Write Mode.

The Edit Menu will indicate Undo Trim at the end of a pass in Trim mode.

If you decide that you want to keep the pass after performing Undo, type

Command Z to Redo the pass.

If Auto Backup was turned on, then the last pass was automatically saved to

disk. Selecting Undo does not affect any files saved to disk. To Undo the pass

and prevent the pass from being saved to disk, use the Abort feature,

described next.

Abort
Abort throws away all moves made during the last pass. 

Normally, if you have turned on Auto Backup, MAX automatically saves each

pass onto the disk. Aborting a pass also prevents the pass from being

automatically saved to disk.

To Abort, press the escape key on the Macintosh keyboard a little before

stopping the program material.

The Abort dialogue gives you the option to either Abort or Keep the last pass. 

Press Return or Enter to abort the pass. 

Click Keep Mix to keep the pass.



SNAPBACK

Snapback automatically inserts a fader move event at the end of the pass. 

To turn Snapback on or off, open the Preferences dialogue (Edit menu) and

select Real Time.

To understand why this might be useful, let’s first look at an example of what

normally happens, without Snap Back. Suppose that you wrote a fader move

and then stopped the tape after, say, 5 seconds. Refer to the figure.

Notice the level at the end of the pass, which is around +5. 

Now suppose that on the next pass, you write a different fader move on the

same channel. This time the fader is moved down. The tape is again stopped

at 5 seconds. Refer to the figure.

Notice the level at 5 seconds, which is around -8. This level would remain

constant for the remainder of the song, until a new fader move is written. But

we might have wanted the level to return to +5, after all, we are only

trimming the first few seconds of the mix. Why should this fader move have

any impact whatsoever on the mix after the first 5 seconds?
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Snap Back prevents this from occurring by automatically inserting a fader

move event at the end of the pass. 

Suppose that Snap Back is checked (on). 

Now we will clear memory, and make the first fader move again. Refer to the

figure.

This time, when the tape is stopped, a fader move event is taken. 

Once again, we write a different fader move on the same channel, and stop

the tape.

Now, because there is a fader move event in memory from the previous pass,

the original level (around +5) is restored at 5 seconds. 

The fader level “Snaps Back” to the position that it had at the frame where the

previous pass ended.
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SOLO MODE

MAX’s Solo mode allows you to hear selected tracks in isolation from the

other tracks. 

MAX’s Solo mode is “destructive” to the mix but “non-destructive” to the mix

file. 

That is to say, when a track is soloed, all other tracks are turned off. The

channel offs, however, are not written into memory, nor are they displayed. 

Thus Solo is used while building a mix, but not used during mix down.

To Solo Tracks
First, to select channels you wish to make solo'ed, press

SOLO LED button(s) on the DA7 panel, or click SOLO

button(s) on the MAX's window. 

Then, use the SEL to solo the track or tracks.

The word “Solo” and a green “LED” will appear on the fader

knob of every channel in solo. 

All other channels are audibly turned off, though the

channel offs are not displayed on the software, nor are they

written into memory.

This allows you to write fader moves on one or a few

channels, without having to listen to the remaining

channels. 

Unsolo All
Clicking on the SOLO LED when lit will turn off any solos

one by one. Unsolo All command allows you to turn all

solo'ed channels off at once.
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Solo Groups
Whenever a SoftGroup master is put into solo mode, the members of the

group are also put into solo. When the master is unsoloed, the members are

unsoloed too.

Solo Safe Mode

When you Solo a channel, any number of “Solo Safe” channels will also go

into solo at the same time automatically. When the channel is un-soloed, the

Solo Safe channels will also un-solo.

This is used, for example, when you want to solo a vocal and want the effects

return channels to also solo at the same time. By setting the effects returns to

Solo Safe, the vocal will never be soloed dry because the effects will

automatically solo at the same time that the vocal is soloed.

To Solo Safe a channel, click on the Selection menu (the small triangle in the

lower right corner of any module in the Custom View). Solo Safe is selected

when Solo Safe is checked. Repeat clicking on the “SOLO PFL” button in the

Control Bar until it turns to “SOLO IP" (in place).

You can temporarily disable solo safe. If the first channel put into Solo is itself

a Solo Safe channel, Solo Safe is disabled. Only that one channel will go into

solo. Other channels may then be soloed individually. This allows you to, for

example, solo an effects return without having to listen to the vocal being

sent to the effect.

Solo Safe applies to individual channels only. You cannot “Solo Safe” a MIDI

Fader, SoftGroup, or Grand Master Fader. Solo Safe is dimmed as a menu

selection if the fader is not a Channel fader.
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CAPTURING MARKERS IN REAL TIME

Most of the information in this manual up to this point has related to mixing

in Real Time, that is, moving faders while time code is being received by MAX.

Later in the manual, 

MAX’s Cue List and Off Line editing will be introduced.

MAX’s Markers serve as not only a powerful production tool, but also may be

considered an important link between the concepts of Real Time and Off Line

mixing.

Simply put, a Marker is a location point with text (words) that is inserted into

the mix. Markers do not change the way the mix sounds or plays back.

Markers are rather like chapter headings, and are invaluable during Cue List

mix editing to help you navigate through the Cue List. The Markers make the

Cue List easier to comprehend, transforming a list of raw “data” into

meaningful information about the mix.

In the Custom View window, if time code is being received, click the MARK

button at any time to capture a Marker.

Markers may also be captured by typing Command ;
If time code is not being received, clicking on the MARK button (or typing

Command ;) opens the Create Marker dialogue. With the dialogue open, you

can type in any text you want and also specify the time that you want it to

appear at in the Cue List.
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The Marker is automatically added to the Locate Markers and Snapshots

menu. It can be quickly selected from the menu, and used as a MIDI Machine

Control Locate point.

When a Marker is captured in real time, the word “Marker” will appear in the

Locate menu (and in the Cue List), along with the exact SMPTE time code

corresponding to when you clicked MARK.

You can later change the word “Marker” to any other text, such as “First

Verse” or “Second Chorus” or “Scene Change”.

Markers may be used as notes to remind you of important edits that may need

to be made to the mix later, such as, “Vocal Overdub Needs Pitch Shift Here”,

or, “Scene Changes to Train Station, remember to insert a Program Change to

the digital delay unit which is inserted on the dialogue tracks. Which Effect

sounds best?”

Thus you have a means of marking all the important sections or transitions

that occur within the mix. This can be used to assist in Cue List editing. These

Markers can also simply be printed out (by selecting Print when the Cue List

window is opened), and used as a permanent record of the mix or as a

reference for program material editing.

Markers may later have their text added to or edited by the Edit Marker

dialogue. To edit a Marker in the Cue List, double click on it to open the Edit

Marker dialogue. 

You may edit the Markers text, or you may convert the Marker into some

other kind of automation event, either a Snapshot, Fader move, Channel

On/Off, or MIDI Event. This procedure will be described in more detail in this

manual in the sections on Cue List editing.
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SOFTGROUPS™

MAX “SoftGroups” feature allows any fader to be a group master. 

This immediately expands the power and flexibility of the mixer, by providing

an additional 15 groups. 

For example, moving fader 2 could simultaneously control the level of

channels 2, 4, 5, 6, 19, etc. Group member channels will also follow the

group master’s status, if Channel On/Offs, Solo and Panning are changed.

SoftGroups are assigned by double-clicking on the fader that you want to
be the master.

Then single click on the faders that you want to assign to the SoftGroup. 

Then press Return or Enter.

Channels assigned to SoftGroups are color-coded for easy recognition.

When a SoftGroup (or the mixer’s Stereo Master fader) is moved, you can

chose whether the group members also move along with the master. 

To make the SoftGroup members move along with the master, check “Group

Members Move with Master” in the Real Time menu.

Notes: 

• Make sure to include both channels, when you assign Stereo channels into a

SoftGroup.

• Stereo Linking should be performed on the MAX window, not on the DA7

mixer window, for Stereo Link channels in a SoftGroup. 

• For a group master, channels assigned to Stereo or Link can not be selected.



EXAMPLE OF A SOFTGROUP ASSIGNMENT

Suppose that you have percussion recorded on tracks 1, 2, 3, 4, and 7, with

an overdub on track 15. Say that you want fader 15 to control all the

percussion tracks.

(a) Double-click on fader 15. The fader’s outline flashes.

(b) Single-click on faders 1 through 4, and 7.

(c) Press Return. 

Notice the colored group indicators, G-15, above the channels assigned to

SoftGroup 15. 

7 4
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RE-ARRANGING SOFTGROUPS IN THE CUSTOM VIEW

In the Custom View, faders may be re-arranged in any order. You may create a

screen which displays a SoftGroup master along with all the faders that are a

part of the group.

By clicking on the Selection menu in the lower right corner of the module,

the pop up menu allows you to change the fader channel number. If any

SoftGroups have been created, they appear in a sub menu.

Here is an example, using the same SoftGroup assignments shown in the

previous example.

First change the Custom View to a higher screen number, using the Mac’s up

arrow key, until you reach a blank screen.

Click in the lower right of any blank module.

Select Fader Module from the sub menu.

Select G 15 from the sub menu.

Then click on an adjacent Section menu in an adjacent module.

Select Fader Module.

Select channel 7.

Repeat the process for channels 1 through 4.

MAX provides the ability to see these alternative views of the mix, so that at

any given time you are only looking at the information you want to look at,

relevant to what you are working on.



REMOVING SOFTGROUP ASSIGNMENTS

Removing a SoftGroup
Double click on the master fader for the channel that you want to un-assign. 

Press the Delete key on the Macintosh keyboard to remove the assignment.

Removing members from a SoftGroup
Double click on the master fader. 

Click on the member's fader that you want to remove from the assignments.

IMPORTANT NOTES ABOUT SOFTGROUPS

Keep in mind that if a SoftGroup fader is at its minimum position, then the

level of any channels that are members of the group will also be at minimum.

When a fader is turned into a SoftGroup Master, 

that fader is automatically part of the group.

In other words, suppose you make channel 2 a SoftGroup master, and assign

channel 1 to be part of the group. Moving fader 2 will control both 1 and 2. 

The master, 2, is part of the group.

When a fader is turned into a SoftGroup Master, 

the moves previously made on that fader are preserved.

In other words, say that you wrote a fade-in on fader 2. 

Then you turn fader 2 into a SoftGroup Master. 

When the mix is playing back, the fade-in will still occur, and it will affect

channel 2 only. But any other moves written on SoftGroup Master 2 will affect

the overall level of channel 2 and any other faders assigned to the group.

When a fader is turned into a SoftGroup Master, the moves previously made

on that fader are displayed independently of the SoftGroup fader moves.
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In the moves previously made on that fader are

displayed independently of the SoftGroup fader

moves.

In the Custom View, you may display and edit both the

SoftGroup Master fader and the Channel Fader.

Normally, Selecting a Fader with the SEL button

enables the individual channel only.

To make the select button enable the SoftGroup

master, select “Faders Control SoftGroups or MIDI” in

the Real Time Menu.

Shown here is an example of how you would write

moves to either the SoftGroup or Channel. 

These faders were arranged in the Custom View side

by side. 

In this example (remember that we were using 15 as a

SoftGroup), click on the Selection menu for Channel

16. Change Channel 16 into G15. That allows you to

view Channel 15 to the left of SoftGroup 15.

(Since you have removed Channel 16 from one screen

of the Custom View, you may want to go to place

Channel 16 on another screen of the Custom View.

Use the up arrow key to advance to a higher screen,

and place Channel 16 anywhere you want it.)

(1) Check “Faders Control SoftGroups or MIDI”.

Then use the SEL button to select the fader before

writing moves to SoftGroup 15. Fader moves made on

fader 15 will affect all channels that are members of the

group.

Note: Operating parameters on the DA7 other than
Faders or Channel On/Offs will not affect, when
checked.

(2) Un-check “Faders Control SoftGroups or MIDI”.

Then use the SEL button to select channel 15. 
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SURROUND PANNER

MAX can automate the Panasonic DA7 Digital Mixer's surround panning. You

can automate surround panning either in real time or off line.

SURROUND PANNING IN REAL TIME

To use the mixer’s built-in panning patterns, write the moves in real time

from the mixer by rotating the encoder wheel. 

If you want to write the moves “free hand”, in any direction, use the mouse to

position the sound in MAX’s Panning window.

First, become familiar with the DA7's instructions regarding the use and

applications of the surround panning feature. These instructions are located

in the DA7 manual.

Prior to writing Surround Panning “moves”, you must first setup 3 things

within MAX:

First, click on the Overwrite... button to open the Overwrite dialogue box. 

Enable Surround.

Next, set the Edit Mode to Write. (type w or use the menu.)

Finally, select the desired audio channel for editing, using the SEL buttons on

the mixer, or clicking on the mode buttons with the mouse.



At the start of this chapter we said that there were two ways to enter the

panning moves, either from the mixer or from the MAX software.

To enter the moves from the mixer, follow the instructions from the DA7

manual. Position the cursor over the desired pattern in the mixer display, and

rotate the encoder.

To enter moves from the software, go to the Windows menu, and open a

Panning Module. Use the mouse to position the audio within the Panning

Module.

The Panning window features a Channel selection pop up menu. Select the

desired channel. You can open multiple Panning modules.

To write the moves, simply start the program material and write the moves by

dragging the mouse or rotating the encoder.

STEREO LINK

If you are using DA7’s Stereo Link feature, MAX will recognize the link, and

automatically pan the adjacent channel to the channel you are currently

mixing. 

Only odd number channels are operable on MAX. 

If you are writing Surround moves to an odd number channel while Stereo

Linked, MAX will automatically also write moves to the channel to the

right(even) of the one you are currently writing.

MAX will also recognize your selection of a complimentary panning pattern

for the two channels that comprise the Stereo Link. 

In the Cue List window, only odd number channels will be displayed for

events of the Stereo channels.
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PANNING AND SOFTGROUPS

MAX’s Surround Panning automation respects any SoftGroup assignments

you have made. Surround Panning moves made to the SoftGroup master will

automatically be applied to the member channels.

For example, say that you have turned channel 12 into a SoftGroup Master for

channels 1 through 11. To do this, double click on the audio fader in channel

12 in the Custom View. 

Then single click on the faders 1 through 11. Press Enter.

From the Windows menu, open the Panning Window. 

Select Channel 12.

On the Panasonic DA7 Digital Mixer, observe the Panning Display. 

Select channel 12 and the display will automatically show the first 16

channels.

Use the mouse to move the panner. Look at the mixer and notice that

channels 1 through 12 are all responding with the same panning moves.

See the previous chapter for more information about SoftGroups.

Notes: 

• If you desire to use the DA7 to create surround sound panning moves, do it

on the DA7 mixer first, before writing or changing the moves on MAX's

window.

• If you desire to use MAX to create surround panning moves, first locate the

yellow outline that identifies which channel will be selected for panning. It

is useful to do this, especially in Tandem operation where it is easier for you

not to notice which channel is selected. 

• Using MMC buttons in the Custom View or the Graphic View will have the

Panning module disappear.  If you desire to keep on displaying the Panning

module, open the MMC Devices dialogue from the Real Time menu (see

page 204) to operate MIDI machines. 
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DISK AND FILE OPERATIONS

Mixes may be saved on your hard disk either manually or automatically using

Auto-Backup. 

To manually save the mix, select Save from the file menu to save the currently

active mix to disk. 

Select Save as... to save the mix in a different folder, or on a different drive, or

with a new name,.

AUTO-BACKUP

MAX’s Auto-Backup feature automatically saves your mix to disk every time

MAX stops detecting incoming time code. 

Backup may be turned on and off from the Backup button in the Control

Bar. You may also turn it on or off in the Preferences dialogue box.

Select the number of “passes to keep” by opening Preferences... from the Edit

menu. Select Backup.  

Click on either Unlimited Backups, or a number from 1 to 99.



Choosing Unlimited vs a Fixed Number of Passes
The number of passes to keep should be selected keeping in mind the

amount of available hard disk free space.

Though mix files may vary in size, suppose a small mix file is 100 K. If Auto-

Backup is on, and you have chosen to keep “Unlimited”, then every time you

make any fader move and stop the program material, a 100 K file be saved to

hard disk. Do 10 passes and you’ve consumed 1 meg of hard disk space. 

This might not be a concern if you have a 1 Gig free on your drive. But if you

only have a 40 Megs free, the disk may become full rather quickly.

Setting a High Number of Backups
Setting Unlimited, or a high number such as 99, will give you the advantage of

having more versions of your mix available. 

Having older versions available from various earlier stages of constructing the

mix may be very useful, especially if you like to experiment and try different

things. 

You may decide to go back and retrace your steps, doing a significant amount

of re-mixing. However, if you set Unlimited or a high number, keep in mind

the rate at which the hard disk space is being consumed.

Setting a Lower Number of Backups
Setting a lower number, such as 8, will assure that a given mix will never

occupy too much disk space. Select a low number if disk space is at a

premium. 

Keep in mind that if a low number is set, you will have less opportunity to

retreat to an earlier version of the mix. (You’ll have fewer opportunities to

say, “Let’s re-open the mix as it stood around 2 AM yesterday, I liked the

direction we were heading”.)

If your disk becomes full, a warning dialogue box will appear informing you

that “the mix cannot be saved because the disk is full”. The mix, including the

last pass, is still in the Macintosh RAM. You may manually save the mix by

inserting a floppy and selecting Save As. Saving to floppies takes longer, but at

least you can finish the mix.
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AUTO-BACKUP

Auto Backup Numbering

Backups are numbered sequentially, that is

[name of mix].1 

[name of mix].2 

[name of mix].3 

[name of mix].4

and so on.

The Auto Backup feature appends an incrementing number to the end of the

name of the mix. 

MAX will never change the name of any mix. 

If you have included a number in the mix name, 

MAX will ignore it.

That is, if you named a mix “my song.1”, and then turned on Auto Backup,

MAX will save the next pass naming the mix “my song.1.1”.
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Auto Backup Example

Say you set MAX’s Preferences to keep the last 3 passes. Suppose the mix is

currently Untitled.

At the end of the first pass, a Save As dialogue box will automatically appear,

allowing you to name the mix.

Type a name and press Enter.

MAX saves the mix automatically appending “.1”, as observable in the

window’s title. 

On the next pass, make some fader or channel on/off moves, stop the

program material. The mix is renamed with “.2” and saved.

Select Open... from the File Menu, and observe the names of the mixes that

have been saved.
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Cancel to exit the Open Dialogue box for now.

Likewise, on the third pass, again observe the names of the mixes that you can

Open.

But notice what happens on the fourth pass. 

Again the mix is automatically re-numbered and saved.

Select Open and observe the names of the mixes.

You had set the Preferences to keep the last 3 passes.

The mixes have not been re-numbered. 

“my song.1” was simply deleted. 

Likewise on the fifth pass, the mix is automatically saved as my song. 5. “my

song.2” will be deleted.

Setting the Preferences to keep a certain number of passes causes MAX to

automatically delete older mixes.



MIX BACKUP TREES

As stated earlier, MAX’s Auto Backup feature automatically performs a Save As

at the end of each pass, each time renaming the mix with an incrementing

number. 

MAX’s Auto Backup feature starts its numbering over again from .1 after you

Open a previously saved mix, or manually select Save As.

Simply put, suppose you Open a mix already called “Mix.1”. Auto Backup is

turned on. 

The first pass will be saved as Mix.1.1, not Mix.2. 

That way, if a mix called Mix.2 already exists, it will not be deleted. The

following pass will be saved as Mix.1.2.

In a similar manner, suppose you have a mix named Mix.2. Perform a Save
As. If you do not change the name of the mix, the standard Macintosh

dialogue box will appear and ask, Replace Existing “Mix.2”?

The next pass will be saved as Mix.2.1, not Mix.3.

That way, if a mix called Mix.3 already exists, it will not be deleted. Then the

following pass will be saved as Mix.2.2.

So, performing either a manual “Save As”, or Opening a previously saved mix,

re-starts the automatic backup numbering over again.

This feature allows you to create mix “Backup Trees”.

Starting with a known good mix, you can “branch off” and make as many

changes as you want. You can always return to the good version of the mix,

without good mixes being deleted. An example follows.
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Mix Backup Tree Example

Suppose Auto Backup is turned on, and set to keep the last 5 passes. Say

you’ve reached a point where you have a good mix of channel on/offs only.

Let’s call it “mix.7”. 

Now you make a few more passes, writing fader moves.

Currently on the hard disk are the last 5 passes, say mix.5 through mix.9. 

If you continue mixing, in a few more passes mix.7 will be deleted. You want

the option of being able to preserve mix.7, that is, the last known good mix of

channel on/offs only.

Open mix.7. Do a “Save as” mix.7. You will be prompted, “Replace Existing

Mix.7?” Click Replace.

The next backup operation will produce a mix called mix.7.1, then mix.7.2,

then mix.7.3, etc. 

By performing a manual “Save As” at critical times while you are building a

mix, you are free to experiment with different approaches to the mix. You can

always retreat to a known, good version of the mix, and start building on it

again. 

The different versions of the mix can be though of as a “Tree”, with branches

consisting of related versions of the mix.

mix.7

mix.8

mix.9mix.8.1 mix.7.2

mix.7.1

mix.10mix.8.2
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RECENT MIXES

The Recent Mixes sub menu is located in the File menu.

The names of recently saved mixes are displayed here.

Select a recent mix to open it.

In the Preferences dialogue box (Edit Menu), you can set how many recent

mixes will appear in the menu.

To do this, open the Preferences dialogue box, click on the “Backup” folder

tab.

Enter the number in the number field, “Show [#] most recent mixes in

Recent Mixes menu.”
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OPENING MIXES WITH DIFFERENT MODULES

MAX allows the user to edit the appearance and functionality of its modules.

(Refer to page 161 regarding editing modules.)

Suppose you have Saved a mix. Then suppose you later edit the appearance

or functionality of a module, for example, you have added an extra switch. 

Then you Open the mix that was saved prior to editing the module.

A warning dialogue box will appear as the mix is opening.

This dialogue box lets you know that the mix you are opening has a module

which, though it has the same name as a module in your current mix, it has a

different appearance or different features.

The dialogue box shows you two modules:

On the left is the current appearance of the module, as it is stored in the MAX

preference file.

On the right is a picture of what the older module looks like within the mix

that you are opening.

The dialogue box is alerting you of this difference, and giving you the

opportunity to use the older module or the newer module.



Don’t Replace
If you click, “Don’t Replace”, the mix file will be opened normally, and no

change will be made to the library of modules or to your preference file.

Replace
If you click “Replace”, the older module within the mix you are opening will

replace the module of the same name in your library of modules stored in the

MAX preference file.

This dialogue box will repeatedly reappear for each individual module that

has the same name but a different appearance or functionality. 

If every module is different, that means that this dialogue box can appear

dozens of times. 

No More Warnings
If you want to Replace or Don’t Replace all the modules at once, without

having to look at the dialogue box for each module, check “No More

Warnings” prior to clicking OK.

The dialogue box will not appear again, until the next time you Open a mix

file which has modules different than your current library of modules.
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MAX GRAPHIC VIEW

The Graphic View displays the mix as curves on a time line.

This allows you to easily see important information about the mix, which

would otherwise not be obvious.

Unlike the Custom View, you can see fader moves “before they happen”, the

fader moves that are coming up later in the mix. You can also look at fader

moves that have already occurred. 

Unlike the Cue List, it is very easy to see how quickly the fader is going to

move, and to detect and correct small irregularities in the mix. 

A fader moving up looks like this:

A fader moving up looks like this:

The “height” of the curve, how far up it goes, represents the fader position.

For example, a fader that has been moved only about half way up looks like

this:

The “slope” of the curve, how steep or gradual it is, represents how fast the

fader is moving.

A fader moving up quickly looks like this:

A fader moving more slowly looks like this:

The Graphic View window is intended mainly for viewing and editing a mix

that has already been written, and not for writing fader moves while time

code is being received.
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Two Key Features of the Graphic View
Most graphics-oriented software requires you to select a drawing tool from a

“tool box” or “palette” prior to editing. MAX does not require this

cumbersome extra step, it is “smart” enough to know when to change the

pointer into the appropriate tool, automatically.

Most software with a “time line” displays some sort of time indicator moving

across the screen from left to right. When the time indicator gets to the

extreme right side of the screen, the whole screen re-draws, and you have to

wait. MAX does not work this way. 

Instead, the current time indicator is a stationary vertical line, and all the mix

graphics move in a smoothly scrolling roll, underneath the stationary time

indicator. The effect looks like a chart recorder. This means that you do not

have to wait for the screen to redraw. 

The time indicator can be re-positioned by you. This allows you to select how

much of the upcoming mix is visible at any time.

Notes: 

• For fader curves of Stereo, only odd number channels represent and

are displayed.

• When inserting an event, for instance Fader moves and Channel

On/Offs, right after the Snapshot Events, you need to take a space of

3 seconds to enter the new event. Sending Snapshot to the DA7

mixer will take time.
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DESCRIPTION OF THE GRAPHIC VIEW

On the left side are the numbers and names of the channels.

A pop-up menu for each channel allows you to re-arrange the order of the

channels.

Use the scroll bar on the extreme right hand side of the window to scroll up

or down reveal other channels as necessary.

To the right of the channel name is a SoftGroup member indicator. 

If the channel is part of a SoftGroup, the group master number and color are

indicated. Otherwise, if the channel is not part of a SoftGroup, this area is

gray. 

In this illustration, channels 1 through 3 are part of a SoftGroup.The Soft

Group master is channel 1. 

Channel 4 is not part of a group.
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To the right of the SoftGroup member indicator is the Fader Edit Mode

Indicator. This tells you if a given channel is in read, write, trim, or manual.

Notice in this illustration channels 10 and 11 are in trim.

Under the Fader Edit Mode indicator is a Channel On/Off Indicator. This tells

you if the state of the channel is on or off. For Stereo channels, only the status

of odd number channel is displayed.

In this illustration, channel 13 is off, while channel 14 is on.

The mix information for each channel is displayed horizontally, like a chart

recorder.

On top is a time line, and there is a user-reposition able current time

indicator.

Above the time line there may be user-reposition able Snapshots (red

triangles) or Markers (blue triangles.)
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Above the Snapshot and Marker area is a rectangular info box. As the pointer

is moved over the graphic view, information about the mix events under the

pointer is displayed in this area. 

The info box shows Channel Number, Name, Status, that is, Channel On/Off

or In, Fader Level, and Time.

The Fader level may be displayed in either numerical data value (as shown

here) or dB.

Fader moves are displayed for each channel as blue curves. 

Channel On/Off states are represented by horizontal green bars.



CREATING A FADER MOVE

Use the mouse to position the pointer anywhere within the horizontal region

that corresponds to the desired channel. Click once to highlight (select) the

channel. 

Position the pointer at the desired time within the selected channel. Click and

drag the mouse to draw a fader move. When finished, unclick the mouse.

If you wish to redraw a section of the fader move, simply click and redraw the

move.

Note: Do not create a fader move on a Linked channel, since faders’ offset

may be broken.

CREATING A CHANNEL ON/OFF

For each channel, above the region where fader moves are displayed, is a

narrow strip for indicating Channel On/Offs. Click in this region and the

pointer becomes a finger tool. 

A small plus sign appears to let you know that you are about to add a new

Channel On/Off. 

Drag to draw a Channel On/Off of the desired duration.

CREATING A NEW MARKER

Click in area directly above timeline to open dialogue box to create a new

marker.

Once in the dialogue box, you may type up to 125 characters. You may also

edit the marker time.

MOVING A SNAPSHOT OR MARKER

Snapshots (red triangles) or Markers (blue triangles) may be simply dragged

to a different time.
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SHOW OR HIDE MARKER AND SNAPSHOT NAMES

To show or hide marker names, click on the blue triangles.

To show or hide snapshot names, click on the red triangles.

Show or hide can also be selected from the Graphic Editing menu.

SHOW OR HIDE MARKER AND SNAPSHOT LINES

To show or hide the vertical lines that extend downward from the markers

and snapshots, select Show Lines or Hide Lines from the Graphic Editing

menu.

SNAP TO MARKER

Snap to Marker, when checked in the Graphic Editing menu, makes it easier

to align events to markers in the Graphic view.

When dragging a selected region of fader moves near a marker, the region

will snap to (align with) the marker.

When extending or moving a Channel On/Off, the start or end of the Channel

On/Off will align to the marker.
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GRAPHIC EDITING OF FADER MOVES

Redrawing Fader Moves: Auto Nulling Feature
When the pointer is anywhere within the horizontal region where channel

moves are displayed, a small circle appears on the fader curve. The circle

“rides” the channel’s level.

When you move the pointer horizontally, this circle traces the top of the fader

curve.

When you click the mouse, the circle becomes a crosshair, and you can begin

drawing a fader move. While drawing the fader move, the arrow pointer goes

away.

This special feature allows you to freely draw new fader moves without

worrying about introducing accidental jumps in level. The pointer doesn’t

even have to be lined up with the previously written curve. Clicking the

mouse always makes the crosshair automatically start drawing from the level

of the previously written curve.

This is a graphic version of auto nulling. Fader moves can be drawn and re-

drawn freely at any time, the MAX software automatically takes care of lining

up the levels of the new moves with the level of the previously written moves.

Smoothing Fader Moves: Auto Smoothing Feature
As fader moves are drawn, the software smoothes out any small irregularities. 

It does this automatically when you release the mouse. 
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Moving Fader Moves with the Hand Tool
You can move a selected region of a fader move to an earlier or later time.

First, select a region by Command clicking and dragging on a fader move.

Then, positioning the pointer over the middle of the selected region changes

the pointer into a Hand Tool. The Hand is used to drag the selected region of

a fader move to make it start and end earlier or later, without changing its

duration.

Drawing Free Hand vs Constrained with Option and Shift. 
Normally, fader drawing is “free hand”, you can draw in any direction with the

crosshair.

To constrain the crosshair, hold the Control key to set an anchor point.

Continue holding the Control Key and move the mouse, but do not click it.

This allows you to draw a straight line in any direction. Click once for the end

point of the line.

To further constrain the crosshair, hold both the Shift and Control keys to set

an anchor point.

Continue holding Shift and Control and move the mouse, but do not click it.

This allows you to draw a straight line constrained to multiples of 90°. Click

once for the end point of the line.
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Copying and Pasting Fader Moves
You can copy and paste a selected region of a fader move to an earlier or later

time, and/or to a different channel.

First, select a region by Command clicking and dragging on a fader move.

Then Copy the move (Command C.)

Then position the pointer to the position where you want to paste the move,

either on the same channel, or on a different channel.

Command Click to produce a flashing I-beam.

Then Paste (Command V) the region.
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GRAPHIC EDITING OF A CHANNEL ON/OFF

Moving Channel On/Off with the Hand Tool
To move a Channel On/Off, move the mouse pointer over the Channel On/Off

bar, anywhere other than the ends. 

The pointer becomes a Hand tool. The Hand is used to drag the whole move. 

This makes the Channel On/Off start and end earlier or later, without

changing its duration.

Lengthening or Shortening Channel On/Offs with the Finger
Tool
To lengthen or shorten a Channel On/Off, move the pointer over either the

very Start or End of the Channel On/Off bar. 

The ends of the bar have shaded handles for changing their length.

Positioning the pointer over the very start or end of a Channel On/Off changes

the pointer into a Finger. 

The Finger is used to drag the start and end handles of a Channel On/Off,

making it shorter or longer in duration.

Splitting Channel On/Offs with the Scissors Tool
To Split a Channel On/Off into two separate moves, position the pointer over

the Channel On/Off bar and Option Click. 

Option clicking changes the pointer into a Scissors Tool. 

The Scissors Tool splits the Channel On/Off into two or more separate events.

New shaded handles appear for each split.

These new individual Channel On/Offs may then be moved, lengthened or

shortened as described above.
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Chapter 11

MAX OFF LINE OPERATION
CUE LIST EDITING INTRODUCTION

MAX’s Cue List allows very extensive and precise “Off Line” mix editing. The

term Off Line is used, as opposed to Real Time, because the time code does

not have to be present in order to make these edits.

Automation events that have been written in Real Time are displayed

numerically on the Cue List. Individual fader moves and channel on/offs,

library events, EQ, pan, aux sends and inserts, dynamics and masters, may be

added, deleted, copied, pasted and modified. Whole mixes or sections of a

mix can also be manipulated in a similar manner. A whole Cue List can be

constructed entirely Off Line, for precision applications such as timed fades

for post production.

It is strongly recommended that you first familiarize yourself with various Cue

List operations before attempting to apply these operations to a real mix.

Though all operations are “un-do-able”, you should Save frequently under

different file names so that you always have the option, (in the event that

confusion develops) of retracing your steps back to a working version of the

mix.

It is important that you verify your Frame Rate selection (Edit menu,

Preferences, Time Code) so that any moves that you create Off Line will have

real frame numbers. For example, suppose you are working with film at 24

frames per second. Setting the Frame Rate to 24 frames per second will make

sure that you do not accidentally create events in the Cue List that happen

during frames 25 through 29, which do not exist in 24 frames per second.

ABOUT THE OFF LINE MENU

The Off Line Menu relates mainly to the Cue List. Most of the items in this

menu are for opening dialogues that allow you to create automation events in

the Cue List. When the Cue List is not opened, most of the items in this menu

are dimmed.



THE CUE LIST AND A SINGLE FADER MOVE

Before working with the Cue List for the first time, do the following: Start

with a new clear mix, either select Clear from the Edit Menu, or select New

from the File menu to open a new Untitled mix.

Start the time code, put a fader into WRITE mode.

(In brief, Open the Overwrite dialogue box and select Faders, then set Edit

Mode menu to Write, and then select the Fader with the SEL button.) Move

the fader a little in one direction, and then stop the time code.

Open the Cue List by typing Command-0. 

In the Cue List you should see at least two events. 

The first event is a Snapshot, which will be discussed later. The second event

is the fader move that you just made. 

Look at the detailed information about the fader move:

Start Time 

When you started to write the fader move.

Event 

What you did, in this case, “Fader Move”. If you have previously named your

tracks using the Names and Labels dialogue box, the name appears here. 

Channel

This is the channel number of the fader move.

Fader Level 

The range of the fader level is from -∞ dB to + 10 dB.
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If you have chosen (in the Preferences dialogue box) not to work in dB, the

range of faders will be displayed as number from 0 to 255.

The Start Level is where the fader was as you began to move it. 

The End level is where it was at the end of the move.

The “Events =” is the number of small “sub events” that comprise the fader

move and represent small level changes with respect to frames.

Channel On/Off 

If you turn a channel on or off, it is indicated here.

End Time 

The time that you stopped writing the fader move.

Note: When inserting an event, for instance Fader moves and Channel

On/Offs, right after the Snapshot Events, you need to take a space of 3

seconds to enter the new event. Sending Snapshot to the DA7 mixer

will take time.

SCROLLING THE CUE LIST

A mix will usually have so many events that they can not be displayed within

the size of the window. Click in the scroll bar on the right of the Cue List to

reveal more of the mix.

As the Cue List is scrolled, a small time-code pop-up window appears at the

top right of the Cue List Window. This special feature allows you to quickly

locate the time of the mix that you want to edit.

Clicking on the arrows at the end of the scroll bar shifts the display about 1

event line at a time. 

Clicking in the region above or below the scroll box shifts the display by

about a third of the visible display, depending on the size of the window.



CLIPBOARD EDITING

You can already start editing in the Cue List using standard Macintosh

clipboard-style editing. 

SELECTING EVENTS

Click to select (highlight) the event.

Shift-click to select multiple sequential events. 

The selection range will be from the first event selected, up to and including

the event that is shift-clicked on.

Command-click to pick off discontiguous events.

Type Command A to select all events.

DE-SELECTING EVENTS

When multiple events are already selected:

Click on any event to select it and de-select the other events.

Command-click to de-select any single event.

To de-select all events, click in any blank area of the Cue List, such as the gray

area to the left of the “equals” button.

Once events are selected, use the Edit menu to 

Clear, Cut, Copy, Paste, or Replace the events.
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Clear 

Deletes selected events from the Cue List. 

Used to remove any event from the mix.

Copy 

Copies selected events to the Clipboard. 

Performed prior to Paste.

Cut 

Deletes selected events from Cue List, and Copies selected events to

Clipboard. Performed prior to Paste.

Paste 

Pastes contents of Clipboard. 

If no event is currently selected, the events in the Clipboard are pasted into

the Cue List preserving their original times. 

For example, you may copy the fader moves from the first chorus of a mix.

Open a new mix, and paste into the new mix an exact copy of the fader moves

from the first chorus of the mix.

If any events are currently selected, the time of the first event selected is used

as an offset time. Events in the Clipboard are pasted into the Cue List with an

offset applied. 

For example, you may copy the first chorus of a mix, and paste in an exact

copy of the first chorus of the mix into the second chorus of the mix.

Replace 

Deletes currently selected events and pastes contents of clipboard.
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Paste Special... 

Opens the Paste Special dialogue box. Permits you to paste the Clipboard

with a manually entered offset of the time, channel, and level.

As an example, say you have channel 3 turn on at a certain time.

You want channel 4 to turn on at the exact same time.

Select the channel off event on channel 3. Copy. 

Select Paste Special...

Check Channel, + 1, Click OK. Observe the results. 

Select the Custom View window, play the program material or other source of

time code, and notice that channels 3 and 4 turn on at exactly the same time.
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Paste Special, Absolute (=) or Offsets (+/-)

MAX lets you work either in absolute values or offset values. 

In the previous example, you entered an “offset” of “+1”. 

(Channel 3+1= Channel 4)

You could have obtained the same result by clicking on “=” and typing a “4”. 

When applications call for editing in terms of absolute values, click on the

equals sign. For example, when you need to Paste Special at a specific time,

that is, “This move must happen at one hour.”

When applications call for editing in terms of offsets, click on the plus or

minus sign. For example, “This move must happen one frame later.”

EDIT BAR

At the top of the Cue List is the Edit Bar.

The Edit Bar contains tool icons and edit fields.

The buttons and icons feature “hot help”, automatic pop-up descriptions of

their function.
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EDIT FIELDS

When you select an event in the Cue List, its parameters are transferred into

the edit fields in the Edit Bar. Events may then be edited by typing in new

values in the edit fields.

When more than one event has been selected, parameters held in common

appear in the edit fields. Parameters with differing values are blanked.

Example of a single fader move selected.

Example of a fader move and a channel on selected.

Example of two fader moves and a channel on selected.



More About the Edit Fields

When an event is selected in the Cue List, its parameters appear in the Edit

Fields. A cursor automatically appears on the first digit of the time.

To edit a time, type the time in the time field. 

Numbers are entered from left to right. 

Click or use the arrow keys to move around to different digits within any

number field. 

Type Delete to backspace over an entry.

Re-type to correct an entry.

Pressing Enter applies the edit. 

The Cue List is re-drawn with the edited values.

Tabbing also applies the edit, and moves the cursor to the next Edit Field. 
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FADER TOOLS

The four icons at the top left of the Edit Bar are tools

called Move, Scale, Crop, Smooth. After selecting an event in the Cue List,

click to select one of these tools before editing a time or level.

A tool icon may be selected “one time”, by single clicking on it. After the edit

is performed, Move is automatically re-selected.

A tool icon may be locked in place by double-clicking on it. After the edit is

performed, you may continue to make more edits using the same Tool.

Double-click on it again to unlock it.

Scale, Crop, and Smooth only affect fader moves.

Move 

Say we change the start time of the fader move. Does this mean

that you want the whole fader move to start and end later? If the

answer is yes, you would have first selected the Move tool.

When the Move tool is selected, any change made to the start of

the fader move is also automatically applied as an offset to the

end time. Likewise, any change to the end time will

automatically be applied as an offset to the start time. 

So the net effect is that the fader move stays the same length. It

just takes place earlier or later.

Move is always selected by default. 

Move applies to any kind of event, such as faders, channel

on/offs, parameter changes, markers, snapshots, and MIDI

events.

If you edit only the start time, the end time is automatically

changed the same amount. 

If you edit only the end time, the start time is automatically

changed the same amount. 

If you edit only the start level, the end level is automatically

changed the same amount. 

If you edit only the end level, the start level is automatically

changed the same amount.



Scale 

Suppose you make a fader move shorter by editing the end

time, that is, making the fader move end sooner. But you want

the move to start at the same time, and you want to preserve any

timing subtleties in the move. 

When Scale is selected, MAX can intelligently “squeeze” or

“stretch” a fader move, preserving all of the nuances of the

move. 

If the move was a slow fade in, making the end time earlier with

Scale selected turns the move into a quicker fade in.

If you edit the start time, the end time stays the same. 

If you edit the end time, the start time stays the same.

If you edit the start level, the end level stays the same. 

If you edit the end level, the start level stays the same. 

The dynamics of fader move are compressed or expanded.

Crop 

Crop allows you to shorten the move. If you change end time,

making it earlier, the move simply ends sooner.

Suppose that you just want to make a fader move stop at some

point. When Crop is selected, when you change the start or end

time, the software simply throws away the rest of the move. 

For example, if the move is a slow fade in from minus infinity up

to 0, making the end time earlier would result in a fade in that

stops at some point before reaching 0.

Smooth 

Smooth causes a straight line to be drawn between the start and

end of the move. 

If the fader move is erratic, selecting smooth will cause extra

steps of resolution to be inserted into the fader move to make

the move smoother.

This can be used to smooth an erratic move, even if you are not

changing the start or end time. Simply select the move in the

Cue List, and choose Smooth Now from the menu.
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OFFSET BUTTONS

Sometimes it is desirable to perform Cue List edits using

absolute times, for example, “make this channel on/off occur at 01:02:34:12”.

Other times it might be desirable to perform Cue List edits in terms of offsets,

for example, “make all these channel on/offs happen 2 frames earlier.”

The Offset Buttons affect whether the numbers you type in to edit an event

will be used as absolute times or offsets.

Equals is selected by default. Equals allows you to enter absolute times. That

means any number you enter (level or time) will replace the previous number

(level or time.)

Click + and the number that you enter will be used as a positive offset.

Click - and the number that you enter will be used as a negative offset.

Alternately, typing +, -, or = will select the buttons.

The buttons automatically reset to = after the edit takes place.

If you want to continue to work with offsets, you may lock the button down

by double-clicking on it. A locked button will unlock if you single click on it

or any other button.

Example of Move with Offset Buttons

Suppose a fader move happens at 1 hour and 10 minutes. 

To make the same fader move happen 3 frames later, type in the Start Time

field: 00 00 00 03. Then click on +. 

Press Enter.
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VIEW “DOCUMENT” ICON

View Events allows you to shorten the Cue List by displaying only selected

prior to editing or printing. 

Clicking on the document icon in the upper right of the Cue List toggles you

from viewing a filtered or unfiltered display, depending on the settings in the

View Events dialogue box.

If the View Events dialogue hasn’t been opened yet, that is, if no View

Events criteria have been set by the user for this particular mix, then

clicking here opens the View Events dialogue box.

VIEW EVENTS DIALOGUE

This dialogue box is normally opened by selecting View... from the Off Line

menu. 

The dialogue makes the Cue List easier to read by letting you specify which

events in the Cue List may be viewed. Events not viewed are still part of the

mix, but are “filtered” out of the Cue List so that they may not be seen or

selected.

(Before going any further, it may be helpful to point out that the channel

names that appear in these pictures were entered in the Names and Labels

dialogue box in the Edit menu.
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Example of View Events

Say that you have a long mix consisting of thousands of events.

Say that you want to look at only the channel on/offs. 

Open the View Events dialogue. 

Uncheck Fader Moves, Snapshots, Markers and MIDI. Click Apply.
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Observe that the Cue List now only shows channel on/offs.

The rest of the mix is still there, it just is not displayed.

Now say that you want to really remove all the fader moves from the mix but

keep the channel on/offs.

Check Fader Moves and uncheck Channel On/Offs. 

Click Apply.
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To remove all the fader moves, select Clear. 

Click the View document icon to see all the events in the mix, which now has

no fader moves in it.

View Events may also be used to assist in finding and selecting a single

channel or a few channels prior to editing.

For example, say that you want to edit a fade out on channel 1 only.

Open View Events, and click to select Channel 1 only.

Then select a time range that the fade falls between.

Click Apply.
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About the View Events Dialogue

Check All 

If the desired view of the Cue List has only a few events filtered out, first

Check All, then proceed to filter out the unwanted events.

Check None 

If the desired view of the Cue List has most events filtered out, first Check

None, then proceed to add back in the events that you want to view.
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Check Which Event Type you Want to View: 

• Fader Moves 

• Channel On/Offs

• Snapshots 

• Markers 

• MIDI (Select the Command and MIDI Channel)

Select a Range of Time.
Type the start and end time of the region of the mix that you wish to view.

Select Channels
Click to select specific channels. 

Shift-click to select a sequential range of channels. 

Command-click to select or de-select any combination of channels.

Scroll to reveal more channels.

Channels are listed first, followed by MIDI faders, SoftGroups, and the Stereo

Master.
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PERFORMING CUE LIST EDITS WITH EDIT BAR

Here is a brief summary of the procedures involved in editing a mix in the

Cue List using the Edit Bar.

Select Events
Click, Shift-click, or Command-click to select the event or events that you

want to edit.

The View Events dialogue may be used to shorten the Cue List and assist in

selecting specific events.

Select a Tool and Offset Button
By default, Move is selected. 

By default, Equals is selected.

Edit the Event
Click on an edit field. 

Type to change the time, level, or channel.

Apply the Edit
The edit takes place when you press Enter, or when you tab away to the next

field, or when you click on another event, or when you select the [Move,

Scale, Crop, Smooth] Now from the Off Line menu. 

To Undo the Edit
Select Undo from the Edit menu, or type Command Z.

After an edit, Move and Equals are automatically re-selected, unless you first

“lock-down” one of the other buttons down by double-clicking on it. 

A locked button will unlock if you single click on it or any other button.
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OUTLINE VIEW “TRIANGLES”
If an event in the Cue List contains sub events, there is a Macintosh System 7-

style triangle to the left of the event. 

Clicking on the triangle reveals the sub events. 

Typing Command left arrow or Command right arrow also shows or hides the

sub events.

Snapshot sub events may be selected and edited in the edit fields.

Fader sub events are dimmed, since they can be observed only and are non

editable.
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CREATING AND EDITING MARKERS OFF LINE

A Marker is simply text that you type, inserted into the Cue List at a selected

time. 

In the “Real Time” section of this manual it was shown how Markers can be

captured on the fly and inserted into the Cue List while time code is being

received.

Markers are useful for marking significant sections of the mix, such as, ‘First

Chorus”, “Third Verse”. 

Markers may also be used as notes to remind you of important edits that may

need to be made to the mix later, such as, “Vocal Overdub Needs Pitch Shift

Here”, or, “Scene Changes to Train Station, remember to insert a Program

Change to the digital delay unit which is inserted on the dialogue tracks.

Which Effect sounds best?”

Open the Create Marker dialogue box by selecting Create Marker from the Off

Line menu.

Alternately, you may type Command-; or click the MARK button in the Control

Bar.

In the Create Marker dialogue box, you type in the desired text up to 125

characters, and specify a time. Press Enter or click Create to insert the Marker

into the Cue List.
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Markers in the Cue List that have been “captured” in Real Time are simply

called Marker. 

They do not have any special text associated with them yet.

When a Marker is selected in the Cue List, only part of its text is displayed in

the edit field.

Markers may have their text added or edited by the Edit Marker dialogue box.

To edit a Marker in the Cue List, double click on it to open the Edit Marker

dialogue box. Then you can simply text-edit the Marker, by typing or deleting

text.

You may also convert the Marker into some other kind of automation event,

either a Snapshot, Fader move, Channel On/Off, or MIDI Event.

If a Marker is changed into a fader move or channel on/off, it loses its

associated text.

Markers may be found quickly by using the Find and Find Again commands in

the Off Line menu.
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FINDING MARKERS

Markers help you quickly locate a specific section of the Cue List without

having to manually scroll.

You can find Markers using the Find Dialogue.

Type Command F to open the Find dialogue. 

You need not type the whole word. 

Just type enough of the first letters to distinguish the text. 

For example, if there is only one Marker that begins with the letter F (such as

First Verse), simply typing the letter “F” and the Return key is enough to find

the marker.

The Find dialogue box permits search from beginning of Cue List, from the

end of the Cue List, or within the current selection.

A search may be made of Markers, Snapshots, or both.

Clicking Previous searches back in Cue List for the previous occurrence of

text.

Type Command G to search for the next occurrence of the text which had

previously been selected using Find. This is a shortcut method for searching

in that it does not open the Find dialogue box again.

Type Shift Command G to find the previous occurrence of the text, searching

back up through earlier events.
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CREATING AUTOMATION EVENTS OFF LINE

The Create dialogues in the Off Line menu allows you to insert new events

into the Cue List.

This is very useful in post production, because it allows you to create

precision fade-ins and fade-outs simply by specifying a start and end time,

(just as you would specify an “In point” and an “Out point” in an Edit

Decision List).

In the Create dialogues, the current mix name is displayed. If you have

multiple mixes open, this will help you keep track of which Cue List will

receive created events.

In the Create dialogues, when selecting a Channel from a scrolling list, the

channel names and numbers will appear if names have been previously

entered in the Names and Labels dialogue box. 
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Create Fader Moves 

Level Range 

Specifies the starting and ending levels for the fader move.

Fader levels may be entered either in dB or a number from 0 to 255.

To edit in dB, open the Preferences dialogue box (in Edit menu.) Click to

select Faders. 

Check the box “Edit Fader Positions in dB.”

When you enter a dB value, the closest actual allowable value will be

substituted.

To enter the minimum level in dB mode, type Option 5, which is the ∞ sign.

Click on “At this time” for the start level of the move, and 

MAX will automatically find the level of the fader at the specified time and use

it as the level at the start of the move. 

Click on “At this time” for the end level of the move, and 

MAX will automatically find the level of the fader at the specified time and use

it as the level at the end of the move. 
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Time Range 

Enter the times when the fade starts and ends.

Select Channels 

To the right of the dialogue box is the channel selection list. 

Click to select which channels will have fader moves created. Shift-click to

select a continuous range of channels. Command click to select or de-select

multiple discontinuous channels.

Press Enter or click Create to create the Fades.

Example 
To create an 8 second fade-out on channels 1 through 16, except channel 3:

Click on channel 1. Scroll down to reveal channel 16. Shift-click on channel

16. 

This selects channels 1 through 16. 

Command click on channel 3 to de-select it.

Enter the start and end times of the fade. 

For the start level, Click on “At this time”. 

For the end level, type 0 if working in numbers 0-255. 

For the end level, type ∞ (option 5) if working in dB. 

Press Enter or click Create to create the Fades. Observe the created fades in

the Cue List.
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Create Channel On/Off Events 

Select Channel On or Off

Time 

Enter the time that the Channel On/Off or In occurs. 

Channel On/Offs are entered in Hours, Minutes, Seconds, and Frames.

Select Channels 

To the right of the dialogue box is the channel selection list. 

Click to select which channels will have Channel On/Offs created. 

Shift-click to select a continuous range of channels. 

Command click to select or de-select multiple discontinuous channels.

Press Enter or click Create to create the Channel On/Offs.
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Create Surround Pan Events

To create Surround Pan events, open the Create Surround Pan Events

dialogue box.

Pan Position

Specifies the starting and ending position for the pan move.

Use the mouse to set the starting and ending positions.

These are also displayed numerically, using the same convention that the

mixer uses, namely:

Left 16 through 1, C for Center, Right 1 through 16.

Rear 16 through 1, C for Center, Front 1 through 16.

Click on “At this time” for the start position of the move, and MAX will

automatically find the position of the channel at the specified time and use it

as the start of the move. 

Click on “At this time” for the end position of the move, and MAX will

automatically find the position of the channel at the specified time and use it

as the end of the move. 
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Time Range 

Enter the times when the pan starts and ends.

Select Channels 

To the right of the dialogue box is the channel selection list. 

Click to select which channels will have surround pan moves created. Shift-

click to select a continuous range of channels. Command click to select or de-

select multiple discontinuous channels.

Press Enter or click Create to create the pans.

Notice how the Pans events appear in the Cue List.

They can be cut, copied, pasted, paste special, and moves.

Like the fader moves, they have a small triangle. Click on the triangle to

expand the observe the sub events that comprise the move. (The sub-events

are dimmed because they are not editable.)
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Create Parameter Change

Parameter Changes include such things as Aux Send levels, Pan, EQ settings,

and Dynamics settings.

A Parameter Change means a continuous change.

In the Create Parameter Change dialogue box, you can create the equivalent

of an automated knob.

For example, you can cause the EQ settings for a given channel to gradually

change their frequency with respect to time. 

(If you want to create a Switch event, such as EQ on and off, use the Create

Switch Events dialogue, discussed in the next section.)

To create a Parameter Change, after opening the dialogue box, select the

desired Parameter from the Parameter menu.

Enter a starting and ending value for the parameter.

Send levels are entered either in dB or a number from 0 to 255.

To edit in dB, open the Preferences dialogue box (in Edit menu.) Click to

select Faders. Check the box “Edit Fader Positions in dB.” When you enter a

dB value, the closest actual allowable value will be substituted.
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To enter the minimum level in dB mode, type Option 5, which is the ∞ sign.

Click on “At this time” for the start level of the move, and MAX will

automatically find the level of the send at the specified time and use it as the

level at the start of the move. 

Click on “At this time” for the end level of the move, and MAX will

automatically find the level of the send at the specified time and use it as the

level at the end of the move. 

Time Range 

Enter the times when the change starts and ends.

Select Channels 

To the right of the dialogue box is the channel selection list. 

Click to select which channels will have switch events created. 

Shift-click to select a continuous range of channels. 

Command click to select or de-select multiple discontinuous channels.

Press Enter or click Create to create the events and insert them into the Cue

List.
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Create Switch Events

Switch Events include such things as EQ on/off, Aux Send Pre/Post, etc.

In the Create Switch Events dialogue box, you can create the equivalent of an

automated switch, not a knob.

For example, you can cause the EQ to turn on or off for a given channel at a

specific time. 

(If you want to create a continuous event, equivalent to turning a knob, such

as a changing EQ frequency setting, use the Create Parameter Change

dialogue box, discussed in the previous section.)

Switch Events are created just like Channel On/Off events.

(In fact, Channel On/Off events are Switch Events.)

After opening the dialogue box, select the desired type of switch event from

the switch event menu. Select On or Off.
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Time 

Enter the time that the Switch Event occurs. 

Times are entered in Hours, Minutes, Seconds, and Frames.

Select Channels 

To the right of the dialogue box is the channel selection list. 

Click to select which channels will have switch events created. 

Shift-click to select a continuous range of channels. 

Command click to select or de-select multiple discontinuous channels.

Press Enter or click Create to create the events and insert them into the Cue

List.
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Create Snapshots 

MAX’s snapshot dialogue will either capture the current state of the mixer, or,

the state of the automation at some point in time of the mix. 

The fader values and channel on/offs displayed will change in real time: move

a fader on the mixer and the number in the dialogue box changes. 

Click on an channel to edit the values for that channel.

Shift-Enter will apply the edited value to all channels.

You may type a name, up to 125 characters, for the Snapshot. Later, you can

Find the name using the Find dialogue.

Type a time and press Enter or click Insert Snapshot to create the snapshot.
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More About Snapshots 

MAX automatically takes one snapshot on the first pass after clearing memory.

The snapshot time is equal to the first time code received.

For example, clear the mix from the edit menu. Start the time code source at

0. Turn a channel off at 5 seconds. Stop the time code. Look at the Cue List. 

There will be two events in the Cue List. 

There is a Snapshot at 0, and a Channel Off at 5 seconds.

The snapshot is only taken if a move is made. 

For example, clear the mix from the edit menu. Start the time code source at

0. Do not make any fader moves or channel on/off moves. Stop the time code.

Look at the Cue List. There will be no events in the Cue List.

The mix must begin with a snapshot. You can confirm this by looking in the

Cue List, the very first event will be a snapshot. Do not write moves before the

first snapshot. 

You may edit this snapshot in the Cue List. Click on the “triangle” to view and

edit the level and on/off state of each channel. If you delete the first snapshot,

be sure to replace it using the Create Snapshot dialogue box.
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Create Library Events (Dynamics, EQ, and Effects)

The Panasonic WR-DA7 Digital Mixer features extensive Libraries of Channels,

Dynamics, and EQ settings.

“Library Events” may be created in the Cue List. These cause

MAX to send commands to the mixer, at user-specified times, causing the

mixer to automatically recall and apply the desired Library setting.

After opening the dialogue box, first select from the Library menu.

The names of the Library entries are displayed in the left column. Click to

select the desired Library name.

Then click to select the channel or channels which will be affected by the

Library event. Shift-click to select a contiguous range of channels, command-

click to select any combination of channels.

Type the time that you want the event to occur, and click Create to create the

events and insert them into the Cue List.
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Create MIDI Events 

Select MIDI Channel 

MIDI Channels range from 1 to 16. 

Select Type of MIDI Event

Select Notes, Poly After Touch, Control Change, Program Change, Mono

Aftertouch, Pitch Bend, Song Select, or Real Time.

Enter Event Parameters

The parameters depend on the type off command, such as Note Name and

Octave, Pitch Bend Amount, etc.

Enter Time

Some MIDI commands have just a Time (such as a Program Change). 

Other MIDI commands have both an On Time and an Off Time (such as

Notes).
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TRANSITION BETWEEN SNAPSHOTS

A “Transition Event” may be inserted between two Snapshots. 

A Transition Event consists of fader moves, that Transition or “dissolve”

between the audio channel levels in each Snapshot.

To create a Transition Event, first select two Snapshots in the Cue List. Then

select Transition Between Snapshots from the Off Line menu. This inserts the

Transition Event. The actual fader moves that comprise the event may be

viewed by clicking on the triangle to the left of the event.

The time that the transition starts is prior to the second Snapshot. The time

may be user set in the Preferences dialogue box. To change the time, select

Preferences from the Edit menu. Then click on the Faders tab. Type the time

in the Transitions Between Snapshots field. The time is entered in frames. 

For example, if your current frame rate is 30 frames per second, then 30

frames is the same as 1 second, 60 frames is 2 seconds, etc.

Suppose your second Snapshot starts at 00:01:00:00. If you want the

transition to start at 2 seconds before the second Snapshot, enter 60 frames in

the Preference.

For example, if your current frame rate is 24 frames per second, then 24

frames is the same as 1 second, 48 frames is 2 seconds, etc.

Note: Any fader events should not exist between the two Snapshots where you

try to insert a Transition Event.
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MERGE MIX

Merge Mix allows you to combine a previously saved mix with the current

mix. The previously saved mix is “merged” into the Cue List of the mix you

are currently working on.

In other words, Merge Mix is a short cut which combines all the following

operations: 

Open, opens a previously saved mix,

Select All, selects every event in its Cue List,

Copy, copies every event,

Paste, pastes the previously saved mix into the Cue List of the mix you are

currently working on.

Merge Mix is found in the file menu. It is only available when viewing the Cue

List. Merge Mix is dimmed when viewing the Custom View. 

This feature allows you to save different parts of a mix as different files, and

later re-combine them to suit the needs of differently edited versions of a

song.

Merge mixing may also be used to create separate Fader and Channel On/Off

Cue Lists, and later combine them.

For various versions of a dance mix, for example, you could first use View

Events to isolate the channel on/offs. 

Select All, Copy, and Paste the Channel On/Offs into a New mix.

Save. Re do the channel on/offs in the old mix, and again, 

Select All, Copy, and Paste the channel on/offs into a New mix.

Repeat this process to create several different mix files of Channel On/Offs

only. These files can later be merged into the file of fader moves, allowing a

client to pick the most effective dance re-mix.

Note: Click on the View Filter to turn it off, before you start Merge Mix.

1 4 3

MAX Off Line Operation 



1 4 4

MAX Off Line Operation 

Merge Mix Example

Suppose the Cue List is showing events that take place between, say,

00:00:00:00 and 00:07:00:00. 

Suppose a previously saved mix file has events that take place between

00:03:00:00 and 00:07:00:00. 

If this mix file is merged, the moves from the merged file will be “dropped

in”, that is, inserted into the Cue List around moves that are already in the

current Cue List.

After the merge is complete, the events from the merged file will remain

selected (highlighted). This permits you to immediately perform an edit (such

as an offset) on the merged events.

Avoid Merging Mixes with Conflicting Moves.

If a particular fader is moving during a certain time, and a mix is merged with

the same fader moving at that same time, a real mess will result. 

The individual discrete events that comprise the fader move may become

“interleaved”, resulting in a fader that rapidly dances up and down on

playback. 

This situation may be identified and corrected as follows.

Remember that, after merging, the merged file will appear as selected

(highlighted) events in the Cue List. If you see a “zebra stripped” pattern in

the Cue List, with identical fader moves at similar times, you may have created

overlapping moves.

You will want to edit this further (by removing the overlapping region) before

playing back the mix.



CHANNEL NAMES AND LABELS DIALOGUE

Each audio channel can be named. Names appear in the Cue List, and also in

every list of channels, such as the View dialogue and the Create dialogues.

Labels are the short text fields that are seen under each fader in the Custom

View.

Click to select a channel number, then type in the name and or the label. The

label appears under the fader in the Custom View. The name is what appears

in the Cue List for every event on that channel.

Press either Tab or Enter to validate the entry.

The Names and Labels dialogue shows the name of the file you are working

on, that is, Mix: “[mix name]”.

Clicking Clear All clears out all the Names and Labels.

Checking “Also apply to new mixes” saves the Names and Labels as a part of

the Preference file. Any new mixes opened will automatically have the names

and labels applied.
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Channel Labels
Channel Labels are shown under the fader within the standard fader module.

They can also appear in any module created or edited with the Edit Module

dialogue.

(Labels may also be entered directly on the Custom View, much like a write

strip on mixer. Simply click in the text field under the fader, and type the

name, such as “kick”, “hat”, etc. Tab advances to the next text field.)

Names may be converted into labels automatically by clicking . 

This takes the first four characters of the name and turns it into a label.

For example, if the channel is named “guitar”, clicking will create a

label in the Custom View under the fader that says “guit”.

This is a time saving shortcut. There are some instances where it will not be

effective to use. 

For example, if the Channel is named, “Lead Guitar”, then clicking 

would create a label in the Custom View that says “Lead”, which may be

unclear.

Labels may be converted to Names automatically by clicking . This

copies the label into the Names table.

For example, if the channel is labeled “guit”, clicking will create a

name in the Cue List for all events on that channel, indicated by “guit” in the

Cue List.

This is a time saving shortcut. There are some instances where it will not be

effective to use. The Cue List is capable of displaying a longer name, and the

labels may be too cryptic.
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PRINTING THE CUE LIST OR TRACK LIST

Print Cue List... prints the Cue List as it appears. 

Be aware that this might be really long! It would be a good practice to scroll

to the bottom of the Cue List and observe the number of pages before

printing.

To shorten the Cue List, use the View Events dialogue prior to printing. It may

be useful, for example, to print only Markers.

A printout of markers may assist in tape editing.

If a Comment has been entered in the Comment window, it is also printed at

the top of the Cue List.

Print Track List... prints a list of all the Channel Names, along with the

Comment.

Selecting either Print Cue List or Print Track List from the File menu opens

the Macintosh’s printer dialogue. The dialogue will depend on the printer

drivers installed in the Macintosh, and which printer has been selected with

the Chooser in the Apple menu.

To print via AppleTalk, AppleTalk must be Active.

To make AppleTalk active, select the Chooser from the Apple menu. Then

click on the AppleTalk Active button. 

Otherwise, you may print to a locally connected Image Writer.

When making AppleTalk Active or Inactive, you will see a prompt reminding

you to connect or disconnect the AppleTalk network, i.e., printer cable.

Turn AppleTalk Off after printing and before mixing.
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Chapter 12

MAX EDIT MODULE DIALOGUE

The topic of editing Modules is related to Custom Views and the Edit Custom

View Dialogue. It is recommended that you be first familiar with the sections

of the manual relating to Custom View, prior to attempting module editing.

Custom Views consist of an arrangement of some number of Modules.

Changes to the Custom Views are cosmetic in nature. They do not affect the

sound of the mix, nor the functionality of MAX.

Individual modules may be pre-defined and taken from a library, or they may

be edited library modules, or they may be created from scratch, using the Edit

Module dialogue. Extensive editing of modules, and creation of new modules,

will affect the functionality of MAX, at least by making it easier or more

complicated to operate. 

ABOUT MODULES

MAX’s Custom View window allows the simultaneous display of up to 96

“modules”. These modules represent the automated mixing console’s

modules. 

The modules feature faders and knobs that move, and switches with LEDs that

turn on and off.

MAX has a library of modules that represent the modules found on the real,

hardware version of the DA7. 

MAX also allows a module’s appearance and function to be edited. Entirely

new modules may be designed by the user. These modules can be designed

to represent automated or non-automated modules, as described below.



Automated Custom Modules

Modules may also be designed by the user to make a particular mix session

easier to manage.

For example, suppose the current mix session involves mixing audio channels

using a fader, a pan knob, and only two Aux sends. A custom module may be

designed that features only these controls, and not the others. A whole row of

these custom modules may be displayed. That way MAX lets you see only the

information you want, without having to look at every control all the time,

making it much easier to concentrate on the mix.

Non-Automated Modules

Even within the most sophisticated mixing consoles, there may still be some

sections that are not automated. For example, the input gain knob.

MAX allows you to create modules that resemble the look of non automated

sections of the mixer.

Once the module is placed in a Custom View, knob and fader positions can

be set with the mouse.

This allows an engineer to save a picture of the settings related to a particular

session, facilitating set up before a re mix. 

This feature is known “recall” on many automation systems.

Automated Virtual Modules

In addition to automating a digital mixing console, MAX can also automate

additional equipment, using MIDI. For example, MAX can automate signal

processors, tone modules, samplers, external MIDI-controlled mixers, or

digital audio workstations.

You can design virtual MIDI modules, which are controlled by the faders on

your digital mixing console. MIDI fader moves can be recorded, edited, and

played back. MIDI faders can automatically move on screen independently of

the audio level faders that are controlling your mix.
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ABOUT THE EDIT MODULE DIALOGUE

The Edit Module Dialogue box is used to create a new module, or edit an

existing module.

To open the dialogue box, select Module from the Edit Menu.

To create a new module, select New Module from the Module: menu within

the dialogue box.

Shortcut:

In the Custom View, notice that each module has a small triangle in the

lower right corner. Clicking here opens a pop up menu for selecting

channel number, module type, etc. Click on the small triangle to reveal

the menu, and drag down to select Module. Then drag to select New

Module from the sub menu. You will be prompted to give the new

module a name. The default name is “Untitled Module.” Click OK to

open the Edit Module dialogue box. 

To edit an existing module, select the module from the Module: menu within

the dialogue box. Then select Duplicate from the Module: menu.

Shortcut:

In the Custom View, to edit an existing module, simply option-click on

any fader, knob, switch, or label. You will be prompted to give the new

module a name. The default name will be the same as the original name,

plus the word “Copy”. Click OK to open the Edit Module dialogue box. 
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Click on the Module: pop up menu. 

Notice above the upper dividing line; 

New Module, Duplicate Module, and Delete Module.

Between the dividing lines are pre-defined modules for your digital mixing

console.

Below the dividing line are where the user-editable modules appear.

Please note that you cannot Edit or Delete the pre-defined modules.

You may, however, Duplicate them, and then edit the duplicated module.

ELEMENTS OF THE EDIT MODULE DIALOGUE

On the left side of the dialogue box is the module that you are creating or

editing.

For a new module, it starts out as a blank panel.

At the top of the dialogue box is a tool bar for selecting the various tools for

placing, moving, and erasing the various controls, labels, and lines. 

The tool bar features “Hot Help” pop up descriptions of each tool.

In the region to the right of the module, various edit fields of information can

appear, dependent upon the kind of things that are currently being edited.
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PROCEDURE FOR EDITING MODULES

Select a fader, knob, switch, popup menu, label, or line from the tool bar.

Click to place it in the module.

If necessary, drag it to the desired location within the module.

Use the eraser to remove it.

Faders, knobs, switches, and popup menus representing automated controls

on the digital mixer must be connected to the mixer using the Connect To:

menu.

If the fader, knob, switch or popup menu is not connected to the mixer, it

will simply exist as a graphic element (that is, a picture.) It is still useful for

recall purposes, that is, it can still display a level and have a name, but it will

not actually affect the mixer in any way.

Once a module has been edited, you may if you wish proceed to edit

additional modules. To exit the dialogue box and keep the edits that you’ve

made, click OK. 

If you wish to discard any edits you have made since the dialogue box was

opened, click Cancel.

The previous steps have simply created or edited the module, and inserted it

into the library of available modules. To actually use the newly edited

module, it must first be placed within one of the Custom View windows. 

To do this, in brief, notice in the Custom View that each module has a small

triangle in the lower right corner. Clicking here opens a pop up menu for

selecting channel number, module type, etc. Click on the small triangle to

reveal the menu, and drag down to select Module. Then drag to select the

module from the sub menu. 

This has just been an overview of editing modules.

Following are more detailed instructions.
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To Place an Item

Click on one of the items in the tool bar, either a fader, knob, switch, popup

menu, label, or line.

Clicking on Faders and holding the mouse down opens a sub menu for

selecting a long throw fader, or a short throw fader. 

Click on Add Popup Menu prior to placing a popup menu. 

Move the pointer over to the left, into the module area, and click to place a

popup menu. 

Click to place a fader.

In a similar manner, clicking on the Knob in the tool bar to select Knobs.

Move the pointer over to the left, into the module area, and click to place a

Knob.

Clicking on Switches and holding the mouse down opens a sub menu for

selecting a from a variety of switch types. Move the pointer over to the left,

into the module area, and click to place a Switch.

Popup menus, unlike knobs or switches, are used to set and indicate the state

of certain mixer functions which have three or four possible states.

Clicking on Labels and holding the mouse down opens a sub menu for

selecting a from a variety of label types. Move the pointer over to the left, into

the module area, and click to place a Label.
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To Move an Item

Once an item has been placed, it can be moved to some extent, depending

upon the size of the item, and the position of adjacent items. Click the

Selection pointer in the tool bar.

Use the pointer to select and move items within the module area.

To Erase an Item

Once an item has been placed, it can be removed. Click the eraser in the tool

bar. Use the eraser to remove items from the module.

Be aware that the pre-defined modules are not editable, so you cannot

accidentally erase necessary control.

To Connect an Item

Faders, knobs, switches, and popup menus intended to represent an

automated control on the digital mixing console must be connected to the

console using the Connect To: menu.

If the fader, knob, switch, or popup menu is not connected to the console, it

will simply exist as a graphic element (that is, a picture.) It is still useful for

recall purposes, that is, it can still display a level and have a name, but it will

not actually affect the mixer in any way.

If the fader, knob, switch, or popup menu is not already selected, first select it

by clicking on it once.

The Connect To: menu appears.

A popup menu can be connect to any one of the following mixer functions:

• Dynamics On/Off and Function,

• Dynamic Stereo Link,

• Surround Enable and Mode,

• Link/Stereo

If you do not want to connect the control, the menu should be set to “* * *”.

For example, a fader set Connect To: * * * will simply exist as a picture of a

fader.

In the Custom View, moving such a fader with a mouse will not affect the

mixer or the mix in any way.

Otherwise, use the menu to connect the control to a real control within the

mixing console.

For example, a knob set Connect To: Pan means that in the Custom View the

knob will act as a real pan pot that can be automated and will affect the actual

mix.



Naming Module Controls

When you click on Knob or Switch, a Name field appears.

When you click on a Fader, no name field appears.

(Audio channels are named using the Channel Names and Labels dialogue

selected from the Edit Menu.)

In the Edit Module dialogue, you can type a name for each Knob and Switch.

The name can then be used by the Cue List window and its related dialogues.

For example, a switch may be given a name, say “EQ IN/OUT”.

When the switch is turned on and off as part of an automated mix, the mix

can be viewed later in the Cue List and the switches name, the words “EQ

IN/OUT”, will appear for every time the switch is turned on and off.

Switches can also be labeled. The label is text that appears to be part of the

switch.

There is a special kind of switch, called a Mode Switch. 

The Mode Switch is used to change an individual channel from Read to Write,

for example.

When editing a module that has a Mode Switch, you can choose to name it

like any other switch. In addition, when naming a mode switch, you have the

option of checking a box.

When the box is checked, the switch will automatically display the current

mode, for example, read, write, etc. When the box is checked, the name field

goes away, because you have chosen to allow MAX software to automatically

name the switch.
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Connecting Labels

When a Label is selected, you can use the Connect To: menu to make the

Label automatically change.

Select “ * * * “ if you want the label to simply be text that doesn’t change.

Example: A label that says simply “L   R”, that is under a Pan knob.

Select “Channel Label” if you want the Label to automatically take on the

channel labels used in the Custom View.

Example: In the Custom View, the abbreviated names of the actual audio

tracks may be typed at the bottom of each module. For example, “KICK” for a

track with a kick drum, “VOC” for a track with a vocalist. Selecting “Channel

Label” means that later, when you actually place your newly edited module

into the Custom View and assign it an audio Channel number, the Label can

be used as a field to display the channel label. 

Select “Knob Value” if you want the label to automatically take on the value of

a knob.

Example: The Label will automatically and in real time display the value of the

knob.

Select “Group Number” if you want the label to automatically indicate if the

channel is part of a group.

Example: If the channel is part of a group, the group number will

automatically be shown in this label.
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Calibration Lines and Calibration Labels

Calibration lines are the lines on the module that show the

position of a fader. 

You can chose to show or hide these lines.

To show calibration lines, check “Show Calibration Lines”.  

To hide calibration lines, uncheck “Show Calibration Lines”.  

A module could consist of only calibration lines. 

Such a module would be useful if positioned along side a

fader module in the Custom View.

Usually, however, calibration lines are used in conjunction

with a fader.



The calibration labels (that is, the dB marks) can be turned off or on by the

user.

They can also be positioned on the left, center, or right of the module.
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Examples

In the following two examples, we will show how to create an automated

module with a fader and pan pot. Then we will show how to create a non-

automated input gain module.

Creating an Automated Module with a Fader and Pan
In the Edit Module dialogue box, Select New from the Module menu. Name

the module “Fader and Pan”. Click OK.

Check Show Calibration Lines. 

Check Calibration Labels Right.
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Select the fader tool. Click to place the fader in the module. 

Connect the fader to mixing console by selecting Connect To: Channel

Fader.

Select the knob tool. Click to place the knob in the module, above the fader.

Connect the knob to mixing console by selecting Connect To: Pan.

Select the label tool. Click to place a label under the knob.

Type “L {2 spaces} R”. Do not connect the label.

The menu should indicate Connect To: “* * *”.

Click OK to keep your work and exit the Edit Module dialogue box.



If you are not already viewing a Custom View, select a Custom View from the

windows menu. To create a whole row consisting of your new module, select

Edit Custom Views from the Edit menu.

Enter Row 1 starts with channel 1.

Select Module: Fader and Pan. The results will look like this.
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Creating a Non-Automated Input and Gain Module

In the Edit Module dialogue, Select New from the Module menu. Name the

module “Input Source and Gain”. Click OK.

Do not check Show Calibration Lines. 

Select the knob tool. Click to place the knob near the bottom of the module.

Do not connect the knob to the mixing console. 

The menu should indicate Connect To: “* * *”.

Name the knob, “Input Gain”.

Select the label tool. 

Place a label under the knob. Label the knob “Gain”.
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Select the switch tool. 
Click to place two switches under the knob.

Do not connect either switch to the mixing console. 

The menu should indicate Connect To: “* * *” for both switches.

Name one switch, “A/B”, and type “B”.

Finally, we will add two text labels under each switch.

Select the label tool. Click to place the labels under the switches. Label it

“A/B”.

Click OK to keep your work and exit the Edit Module dialogue box.

If you are not already viewing a Custom View, select a Custom View from the

windows menu. To create a whole row consisting of your new module, select

Edit Custom Views from the Edit menu. Enter Row 1 starts with channel 1. 

Select Module: Input Source and Gain. See figure.

You can further edit the module, adding a Phantom power switch.
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Chapter 13

MAX'S AUXILIARY MIDI CONTROL
PORT SETUP

If only one mixer is connected to the Macintosh, you can control and

automate MIDI equipment by connecting a MIDI Interface the unused serial

port. 

Select Port Setup from the Preferences dialogue box in the Edit menu. 

The “Automation Port” is the port that the mixer is connected to.

The software will not permit selection of the Printer port if the AppleTalk

network is Active. Use the Chooser make the network Inactive if you plan on

using both mixer and MIDI.

If Echo MIDI is checked, any MIDI data that comes into the MIDI interface will

be “echoed” back out of the MIDI interface.

Click on OMS MIDI Setup to open and edit your OMS Setup.

The Sync Source defaults to the mixer’s time code input.

To sync MAX to MIDI Time Code, select MTC (OMS) and the name of the

source device.



MIDI MACHINE CONTROL

MAX software features an MMC Control Panel, to provide basic transport

control of Digital Multitracks and other MMC-compatible equipment from the

Macintosh keyboard.

Basic transport control is provided, in addition to locates.

To send a locate, type the locate time and click the locate button in the

control bar.

Snapshots and Markers are automatically converted into locate points. To

locate to a Snapshot or marker time, select the Snapshot or Marker from the

locate menu. Then click Locate.

The MMC Control Panel transport buttons are selected by clicking on them. 

Under the Control bar more detailed settings are available.

Click on the On line button to enable MMC so the button turns to green. 

Click on any Track buttons you desire to enable recording so the buttons turn

to red.
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REAL TIME MIDI AUTOMATION

Along with mixer automation, MAX software can act as a controller of virtually

any MIDI compatible equipment such as digital signal processors, samplers

and hard disk based digital audio workstations.

MAX is not a MIDI application per se, that is, the software communicates with

the mixer at a higher speed using RS-422 But while the Macintosh is

communicating through its modem port to the mixer via RS-422, the

Macintosh’s printer port may be connected to a MIDI interface. The MIDI

Interface is connected to MIDI equipment, either a direct connection, or via a

programmable MIDI Patch Bay.

You may re-assign up to sixteen of your mixer’s faders to be MIDI controllers. 

You can do this “on the fly” during the course of a mix. 

Thus you can perform an automation pass of signal processor control, and

then do another pass of audio channel fader moves, using the same faders.

When you re-assign your mixer’s faders to be MIDI controllers, you have not

lost the use of them for audio mixing. 

MAX will independently play back both audio channel automation moves and

MIDI moves at the same time. 

MAX software will also record MIDI in real time, from an external controller

such as a keyboard.
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CREATING MIDI FADERS

Faders are turned into MIDI Faders in the Custom View, by clicking on

Selection pop up menu, in the lower right of each module. Select MIDI.

Select a controller number.

The fader knob turns blue.

For example, make fader 7 into a MIDI fader that sends MIDI Controller

number 0 on MIDI channel 1.

Moving this fader will now result in MIDI Controller commands being sent

out of the Macintosh MIDI interface.

The MIDI Controller number and channel may be changed in the MIDI Faders

dialogue box, discussed next.
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MIDI FADERS DIALOGUE

After creating MIDI faders in the Custom View, you may change the MIDI

Channel and Controller number of the faders in the MIDI Faders dialogue

box.

Open the MIDI Faders Dialogue box from the Off Line menu.

You may create up to 16 MIDI faders within one mix file. 

The dialogue always shows the 16 possible MIDI faders, designated “mf-”,

whether or not you’ve created any MIDI faders.

As MIDI faders are created in the Custom View, they appear in the MIDI Fader

dialogue with their actual fader number.

For example, if fader 7 is turned into a MIDI fader, it appears in the MIDI

faders dialogue as “mf7”.

To change the MIDI Channel or Controller number:

Select one of the MIDI Faders from the Faders list on the right of the dialogue

box. Select the Controller number from the menu.

Select the MIDI Channel, 1 through 16. 

Usually each device being controlled has its own unique MIDI Channel

number.

Example, to control and automate a signal processor, say that you want to use

8 faders of the mixer. Create 8 MIDI faders in the Custom View. Open the

MIDI Faders dialogue box.

Click on each MIDI fader, and set the MIDI channel of the MIDI fader to

match the MIDI channel of the signal processor. Click OK to exit the dialogue

box.



WRITING AND EDITING MIDI FADER MOVES

You may write and edit MIDI fader moves in real time exactly the same way

that you write and edit channel fader moves. 

The fader is put into Write or Trim. The fader is Selected manually with the

SEL button, or automatically with SoftTouch.

In Read mode, these MIDI faders will be automated, they will move on the

Custom View as MIDI data is sent out, allowing you to automate signal

processors and other MIDI devices as part of the mix.

Mixing with both MIDI Faders and Channel Faders
The same fader on the mixer may be used for writing both MIDI fader moves

and audio Channel moves.

MIDI fader and the audio Channel can have completely different moves. For

example, the MIDI fader #3 fades up while the audio fader #3 fades down.

You can view these moves in the Custom View.

Important!

Once you have turned a fader into a MIDI fader, the mixer’s fader can control

either the MIDI fader or the audio channel. 

Check “Faders Control SoftGroups or MIDI” in the Real Time menu to make

the mixer’s fader control the MIDI fader.

Note: Operating parameters on the DA7 other than Faders or Channel
On/Offs will not affect, when checked.

Uncheck “Faders Control SoftGroups or MIDI” in the Real Time menu to

make the mixer’s fader control the audio channel.
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Example

Suppose that you want to use fader #4 on the mixer to

write both MIDI fader moves and channel (audio level)

moves.

First, make fader #4 into a MIDI fader by selecting MIDI

from the Selection pop-up menu in the lower right

corner of any module.

For clarity, we will place audio channel #4 and MIDI

fader #4, side by side, on a blank Custom View. 

Both faders can be controlled by the mixer’s fader #4.

Select an unused Custom View from the Windows

menu.

Click on any Selection menu and select MIDI fader 4.

Click on an adjacent Selection menu and select channel

4.

Move fader #4 on the mixer.

Notice that if “Faders Control SoftGroups or MIDI” is

checked in the Real Time menu, the mixer’s fader only

moves the MIDI fader.

Notice that if “Faders Control SoftGroups or MIDI” is

not checked, the mixer’s fader only moves the channel

fader.

Now you can use one fader on the mixer to write two

different kinds of fader moves. Simply check or uncheck

“Faders Control SoftGroups or MIDI” prior to selecting

the fader in Write mode.

Check the Overwrite dialogue prior to the pass, and

make sure that “Faders” are Overwrite enabled.
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REAL TIME MIDI RECORDING

MAX can record MIDI data that originates from an external MIDI Controller,

such as a keyboard or a fader controller (e.g. JLCooper FaderMaster Pro.)

To Select Real Time MIDI Recording
Check MIDI Record from the Real Time menu. While MIDI recording is on,

any MIDI information coming into the Macintosh MIDI interface (while

SMPTE is coming into the mixer) will be recorded. 

Turn off MIDI Record when not in use, to prevent the accidental recording of

undesired MIDI data, which could use up valuable memory space.

MIDI Record (Real Time Menu)
Turns MIDI Record On or Off. 

When MIDI Record is On, and time code is received, the software can record

MIDI commands received on a MIDI interface connected to one serial port of

the Macintosh. The serial port is chosen in the Port Setup dialogue box.

The MIDI Record menu item is dimmed (not available) until MIDI is checked

in the Port Setup dialogue box.
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MIDI Input Filter 
When using the MIDI Record feature, setting the MIDI Input Filter allows

selective filtering out of specific MIDI events, by channel and kind. This helps

save memory by avoiding the recording of unwanted MIDI data.

You may choose to filter out Notes, Poly After Touch, Controllers, Program

Changes, Mono Aftertouch, Pitch Bend, Channel Mode commands, System

Exclusive, System Common, and Real Time. The MIDI message called “Active

Sensing” is always filtered.

For example, you may wish to filter out the MIDI command “After Touch”,

which is often sent out of a keyboard in large volumes. It may not be needed,

and would only consume memory if not filtered out.

Check all or none to immediately select all filters or no filter.
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CREATING MIDI EVENTS OFF LINE

The Create MIDI Events dialogues in the Off Line menu allows you to insert

new MIDI events into the Cue List.

This is very useful in post production, because it allows you to create

precision signal processor changes occurring at an exact points in time code.

For example, at 01:30:21:00, the scene change requires that the signal

processor / delay unit changes from a “Large Hall” audio effect to a “Small

Room” effect. (Or the sound of a cave full of Bulgarian fruit bats.)

Create MIDI Events accomplishes this by allowing a MIDI Program Change to

be inserted at a certain point in time.

The current mix name is displayed. If you have multiple mixes open, this will

help you keep track of which Cue List will receive created events.

In the Create Dialogues, when selecting a Channel or MIDI Event from a

scrolling list, the channel names and numbers will appear if names have been

previously entered in the Names and Labels dialogue box. 

Select MIDI Channel 
MIDI Channels range from 1 to 16. 

Since MIDI supports 16 different channels, up to 16 different devices may be

automated simultaneously.

1 7 4

MAX's Auxiliary MIDI Control



Select Type of MIDI Event 

Program Change 

The most versatile MIDI command for automation purposes. 

At a specific Time Code, MAX sends a MIDI Program Change to an outboard

signal processor, such as a rack-mount MIDI controlled equalizer or multi-

effects processor. The reception of a Program Change causes the signal

processor to recall a new preset of parameter settings from memory. Program

Changes also range from 0 to 127. Be aware however that some MIDI devices

respond to Program Changes 0 through 127 as if they were numbered 1

through 128.

Notes

MIDI Note Commands can trigger Samplers, Synthesizers, Tone Modules, and

Drum Machines. Also certain signal processors respond to Note Commands,

changing, for example, their interval of pitch-shift. Outboard MIDI controlled

VCAs will also usually respond to Note commands.

The specific Note is selectable, as is its Velocity Value. Click on the Note to

open menu to select the desired note. The Velocity usually, but not always,

determines the loudness or brightness of the Note.

The Pitch of the note is given in terms of a name and an octave, like D2. C3 is

middle C on most keyboards. Note Velocity values range from 0 to 127.

Pitch Bend 

Pitch Bend Commands may be sent along with Note Commands to “bend” the

Note up or down.

Pitch Bend Commands may also be merged with sequencer data to cause a

MIDI sequence to play transposed by some interval. MIDI merging requires a

dedicated piece of hardware.

After Touch

After Touch commands may be sent along with Notes to modify the sound of

the note. Most tone modules are programmed such that they add some

amount of amplitude or frequency modulation upon reception of these MIDI

commands.
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Controller Commands 

MIDI Controller Commands are recognized by nearly every make and model

of signal processors. A series of Controller Messages may be used to smoothly

sweep EQ or change any effect parameter, including Room Size, Delay Time,

Flange Speed, Etc.

A particular MIDI Controller, #7, is called MIDI Volume. This is recognized by

nearly all MIDI devices. A tone module, signal processor, or synthesizer will

change its audio output level in response to this command.

Controller Commands may also be sent out along with Notes to modify the

sound of the Note. A particular MIDI Controller, #1, is called MIDI

Modulation.

Controller values range from 0 to 127. 

Song Select

Recognized by some sequencers. Sent prior to a start command to select

which song will play.

System Real Time

Sequence Start and Stop will start and stop a MIDI sequencer or drum

machine that has been set to Internal Clock. If synchronization of a hardware

sequencer or drum machine is required for the project, use an external

synchronizer to accomplish the conversion from SMPTE time code to MIDI

Clock.

Sending the MIDI commands Start and Stop might be useful to trigger a drum

pattern for a sound track.
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THE MIDI NAMES AND LABELS DIALOGUE

Normally, the names of MIDI devices are automatically imported from OMS or

FreeMIDI. In that case, this menu item is not needed and is dimmed.

When OMS or FreeMIDI are not present, you can enter MIDI Names and

Labels using the MIDI Names and Labels dialogue box (Edit Menu).

(When OMS or FreeMIDI are present, the MIDI Names and Labels menu item

is not needed so it is dimmed.)

This dialogue box allows you to enter names for Program Changes, Notes,

and MIDI Channels.

Select MIDI Channel from the Name menu.
Each MIDI device under control will have a unique channel number. Click to

select a channel. Type in the brand name the connected MIDI device.

Select Notes from the Name menu.
Select a Note number and MIDI channel. Type in the name of a specific sound

or sample.

Select Program Change from the Name menu.
Type in the name of a specific effect within a signal processor.

Press either Tab or Enter to validate the entry.
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MIDI APPLICATIONS

MIDI-compatible signal processors including equalizers delay units may have

their settings changed via Program Changes or Controller Numbers.

Use the faders on your mixer to “ride” pitch transposition, room size changes,

delay times, etc.

MIDI Events that have been recorded in Real Time can be viewed and edited

using the Cue List. New MIDI Events can also be created with the Cue List. 

What Not to Do with Real Time MIDI Recording
We should note here that the MIDI Recording feature should not be confused

with a MIDI sequencer. There is no concept of tempo, only of frame numbers.

A MIDI note can only occur on a given frame. Since SMPTE only has 24 to 30

frames per second, the resolution of SMPTE isn’t adequate for “musical”

applications. 
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MAX PREFERENCES (EDIT MENU)
MAX remembers certain basic user settings, such as fader labels and names,

Auto Backup, Real Time menu selections, etc. These are automatically saved

in a Preference file. 

(As with other Macintosh applications, the Preference files reside within the

Preference folder which is inside the Macintosh System folder.)

The Preference file automatically opens when you launch the MAX software.

MAX permits multiple, user-selected Preference files.

That means, for example, if you use different Preferences on different kinds of

mixing projects, you can create a different Preference file for each kind of

project. 

Alternately, if more than one engineer uses the automation system, each

engineer can have their own Preference file.

Open the Preferences dialogue from the Edit Menu.

The Engineer pop up menu in the upper right allows you to select, create,

and delete Preference files.

The Preferences are arranged in a “Folder Tab” form.

Click on a tab to select the Preference you wish to edit.

Note: Prefs listed below will not be affected by changing the entry of

engineer.

General Tab: Copy comments to Finder comments, Trim until end

Time Code Tab: Frame Rate

Fader Tab: All prefs in this tab

Real Time Tab: All prefs in this tab

Back Up Tab: All prefs in this tab



GENERAL

Copy Comments to Finder Comments 
Each mix may have a comment. 

The mix comment is a small text file that is opened and edited by selecting

Comments in the Edit menu. 

If you check this preference, then the comments that you enter in MAX will

automatically transfer themselves into the comment field that you see when

you Get Info (Command I) on a file within the Finder. 

Remember, however, that Finder comments are erased if the Macintosh

Desktop file is deleted and re-built. 

Use names from “...” in new mixes
Checking this box copies the names and labels from the current mix and saves

them in the Preference file. All subsequently opened new mixes will have the

same names and labels already present.

Use View, Window Size, and Position in new mixes
Checking this box saves the currently displayed view, window size and

position in the Preference file. All subsequently opened new mixes will open

to the same view.

For example, if Custom View #5 is currently displayed, subsequently created

New mixes will also open to Custom View #5.
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Use Custom Views in new mixes
Checking this box copies the Custom Views and saves them in the Preference

file. All subsequently opened new mixes will have available the same set of

Custom Views.

Number of mixers 
Check whether one or two mixers are connected to the Macintosh serial

ports.

Trim Until End 
In Trim mode, fader moves are offset or Trimmed. 

For example, you can make a certain vocal track “a little louder overall”,

bringing it out in the mix, without erasing the fader moves for the track.

Trimming a fader always involves setting the fader to some arbitrary position,

and then going into Trim mode. Then the track is Trimmed by moving the

fader a little bit up or down. Then, when you are finished Trimming the fader,

you generally return the fader to the position where it was at the beginning of

the Trim. This is done by lining up the fader with a small yellow arrow called

the Trim Reference Point.

“Trim Until End” determines what the MAX software will do if you do not

return the fader to its where it was at the beginning of the Trim.

Always 
Click here to have the software automatically apply the Trim to the end of the

mix.

In other words, say you have a vocal track. You want it louder. You put MAX

into Trim mode. You select the fader with the SEL Buttons. You start the

program material, then nudge the fader up a little. Then you stop the

program material. 

Because you clicked “Always”, the software makes the vocal track louder for

the whole song, even though you stopped the program material.
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Never 
Click here to never have the software automatically apply the Trim to the end

of the mix.

In other words, say you have a vocal track. You want it louder, but for just a

short section. You put MAX into Trim mode. You select the fader with the SEL

Buttons. You start the program material, then nudge the fader up a little.

Then you stop the program material.

Because you clicked “Never”, the software makes the vocal track jump back

down to its original level for the rest of the song.

Ask First 
Click here to have the software always ask you if you want to apply the Trim

to the end of the mix.

In other words, say you some number of vocal tracks and instrumental tracks.

You want the vocal tracks louder, but for just a short section. You want the

instruments louder for the whole song.

You put the mixer into Trim mode. You select the fader on the vocal track

with the SEL Buttons. You start the program material, then nudge the fader

up a little. Then you stop the program material.

You do another pass, again with the mixer into Trim mode. You select the

fader with the SEL Buttons. You start the program material, then nudge the

fader up a little. Then you stop the program material.

Because you clicked “Ask First”, each time you stop the program material, the

software gave you the option (by means of a dialogue) whether or not you

wanted the Trim applied all the way to the end of the mix.
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TIME CODE

Frame Rate
If you intend to do Off Line editing prior to running time code, select the

desired frame rate of the time code first. 

Normally, the system will automatically detect the frame rate and set itself

accordingly. But if you do Off Line editing first, before running time code,

manually setting the frame rate here in the Preferences dialogue will assure

that no events occur at invalid frame numbers.

Chose either:

24 for film. 

25 for European video. 

30 df will work with both 30 df and 29.97 df for U.S. video. 

30 will work for both 30 and 29.97 for general audio use without video.

Flywheel allows the automated mix to continue to run for a very brief period,

even after time code is no longer received.

This allows, for example, the mix to continue to play when the time code is

intermittent. The amount of flywheel is entered in frames, either 8, 16, or 32

frames. This corresponds approximately to 1/4, 1/2, and 1 second. 
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FADERS

SoftTouch Time Out 
The SoftTouch feature is turned on or off from the Real Time menu, or by

clicking the TOUCH button in the Control Bar.

When the feature is turned on, a fader will go immediately into Write or Trim

when you move it, so you don’t have to press any SEL Buttons. 

This Preference item sets how long it takes after you stop moving the fader for

the fader to automatically return to Read mode. You may enter 1 through 31

seconds in whole second intervals.

Transitions Between Snapshots
A Snapshot is an automation event representing the state of all the mixer’s

automatable parameters.

It is possible to create a “dissolve” between two snapshots.

This is done in the Cue List, by selecting two Snapshots. Then, in the Off Line

menu, select Transition Between Snapshots.

A new event will be created in the Cue List, which will consist of the dynamic

moves required to perform a smooth transition over time of all continuous

parameters (such as level changes.)

Switched parameters such as Channel On/Offs will switch at the time of the

second Snapshot.

This Preference item allows you to set the default Transition Time for

Transition Events that are created in the Cue List.
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Fader Interval and Directionality 
These items do not affect the way a mix sounds. 

They only affect the way the mix looks in the Cue List, by providing a logical

and easier to read view of the mix. 

Fader Interval and Directionality allow you to display more events, (allowing

more precision in editing) or fewer events (allowing an easier to read Cue

List.) 

Directionality (Check on or off)
When checked, moving a fader up and down is displayed as two events in the

Cue List. When not checked, moving a fader up and down is displayed as one

event in the Cue List.

Fader Interval (a time, in terms of frames)
When you move a fader, pause, and then continue to move the same fader,

this can be displayed as one or two events in the Cue List. 

The Fader Interval is the amount of “pause” time that determines whether the

fader move is displayed as one or two events in the Cue List. 

The Fader Interval is a time, entered in terms of frames. The default setting is

60 frames, that is 2 seconds at 30 frames per second.

That means that if you write a fader move, and then pause, and then wait

more then 2 seconds, you get two separate events indicated in the Cue List.

Selecting a smaller number results in a longer Cue List. Selecting a larger

number results in fader moves being grouped together and a shorter Cue List.

Group Members Move with Master
When checked, moving a SoftGroup master or the stereo grand master will

cause all the members of the group to also move.

Edit Fader Positions in dB
When checked, fader positions are expressed and edited in the Cue List using

dB values. When unchecked, fader positions are expressed and edited in their

decimal data values, typically ranging from 0 to 255.
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REAL TIME

Always Take Snapshot on 1st Pass
Check to turn on. When checked, a snapshot is automatically inserted into the

mix on the first pass after clearing memory, regardless of whether or not

anything else is written. 

Normally, this feature is turned off. The snapshot is not kept unless an actual

move is written, such as a fader move or channel on event. That way, if you

simply start and stop the time code, without writing a fader, knob, or switch,

the mix is still “clear” with nothing having been written.

The possible advantage to turning on “Always Take Snapshot on 1st Pass” is

that it makes it possible to do a pass which just writes a single snapshot. You

set up your initial mix, clear memory, and start the program material, and the

snapshot is written.

Snapback
Check to turn on. Snapback automatically inserts a fader move or a channel

on/off at the end of every pass. 

These extra snapshots in the mix assure that any real time edits made toward

the beginning of a mix will not have an impact on the rest of the mix. The

levels will always “snapback” after the after the edit.

Turning snapback on, however, results in multiple fader moves or channel

on/offs in the mix, which may make Cue List editing more complicated.
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BACKUP

This is a very brief description of Auto Backup, please refer to the chapter

about Auto Backup for more information.

Auto Backup is the MAX feature that automatically saves the mix to disk. At

the end of each pass, if new moves have been made, the mix is saved with a

number appended to it.

Auto Backup may be turned on or off either in the Preferences dialogue or

with the BACKUP button in the Control Bar.

Select Unlimited Backups and every pass will be saved as a separate mix file,

limited only by the space available on the hard disk.

Select Keep last [#] passes, and type in a number from 1 to 99. MAX will keep

that number passes. When the selected number is exceeded, MAX will begin

to delete older versions of the mix.

Show [#] most recent mixes in Recent Mixes menu

The Recent Mixes sub menu is located in the File menu.

The names of recently saved mixes are displayed here.

Select a recent mix to open it.

This Preference item selects how many recent mixes are displayed in the

Recent Mixes menu.
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PORT SETUP

Select the Automation Port, that is, the Port connected to the mixer. By

default the Modem port is selected. Chose the Printer Port only if the Modem

Port is not available, since the Modem Port will tend to be more reliable for a

single mixer.

If two mixers are connected, then both ports will be used. 

The lower numbered channels correspond to the mixer connected to the

modem port.

MIDI
Check to use MIDI. If only one mixer is connected, MIDI uses the port not

being used by the mixer.

Click OMS MIDI Setup to open OMS if OMS is installed.

OMS device names will automatically be imported and displayed in the Device

menu. (If OMS is not present, the menu will say by default “MIDI Device.”)

Check Echo MIDI to: MIDI Device if you want incoming MIDI data to be

“echoed”, that is, re-transmitted, back out of the MIDI output.

Sync Source
Select the mixers time code reader. If two mixers are connected, time code is

read by the mixer connected to the Printer port.

Alternately, if OMS is installed, you can select MIDI Time Code as a Sync

Source.



MACHINE CONTROL

Pre Roll is a time in seconds that is automatically subtracted from locate

commands sent from MAX.

It is usually a non-critical amount of time intended to allow multiple

synchronized machines to chase and lock.

For example, suppose you use the Locate pop up menu, and Click Locate in

the control bar, to make the program source (tape recorder) start at a

particular verse of a song. If you have several digital multitracks, it will take a

certain amount of time before all machines become synchronized and begin

to play back music that you can listen to and mix. By the time that all the

machines are synchronized, you may be well past the part of the music you

wanted to listen to.

If the time it takes for them to synchronize is, say 5, seconds, then enter 5

seconds as your Pre Roll time.

The next time that you issue a locate to a particular verse, the locate time sent

will be 5 seconds before the verse begins. Then, by the time the verse begins,

all the machines will be synchronized and you can begin mixing.
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Machine and ID
Machine names and MMC ID numbers are automatically imported from OMS.

Number of Tracks
Enter the number of tracks for each MMC machine.

Time Code Master
Check if the selected Machine is the Time Code Master.

Do not check if the selected Machine is a slave to another machine,

synchronizer, or sync card.

Offset
Allows entering an MMC Offset for each machine, other than the time code

master.**
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Chapter 15

MAX SOFTWARE MENUS
APPLE MENU

Contains the “About M.A.X.” box. 

Displays version of MAX Software.

Shows total memory available for

mixes. Shows memory allocated

and consumed for each opened

mix, and Undo and Clipboard

buffers.

FILE MENU

New 
Opens New, Untitled mix. MAX permits you to have

multiple mixes opened at the same time. The one that’s

checked in the Windows menu is the one that plays back.

This allows you to quickly compare mixes and make cut /

copy / paste / edits from one mix to another. New mixes are

numbered “Untitled-1”, “Untitled-2”, etc., until you save and

name them.

Open 
Opens previously saved mix.

Recent Mixes
Sub menu displays and opens recently saved mixes. 

The number of recent mixes displayed may be set in the Preferences dialogue

box.

To change the number of recent mixes that appear in the Recent Mixes menu,

select Preferences from the Edit menu. Then select Backup. Then tab and type

the number of recent mixes.



Close 
Closes currently select mix, does not quit application. 

Gives you dialogue “Don’t save, cancel, and close”

Save 
Standard Macintosh dialogue box. 

Saves currently open mix to disk.

Save As...
Standard Macintosh dialogue box. Saves currently open mix to disk, under a

new name or to a different folder.

Merge Mix 
When the Cue List is open, Merge Mix opens a previously saved mix and

merges it into the currently opened mix.

Revert 
Closes currently selected mix without saving. Opens last saved version of mix

with same name. The net effect is a massive “undo” that looses all changes to

the mix since you’ve last saved.

Page Setup 
Standard Macintosh dialogue box. Opens installed Macintosh printer driver

setup. Allows you to set options such as page orientation, size, etc.

Print Cue List 
Prints Cue List, allows you to limit page numbers printed. The appearance of

the printed Cue List may be changed by a number of factors, including the

View dialogue box (Edit menu), and certain things in the Preferences dialogue

box.

Print Track List 
Prints list of all channel names and numbers.

Quit 
Exits application with options to Don’t Save Changes, Cancel, and Save.
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EDIT MENU

Undo [last operation] 
Standard Macintosh interface Command Z, which permits

you to undo the last operation. 

Typing Command Z a second time Redoes the last

operation.

Cut
Cuts selected events from Cue List and pastes them on the

Clipboard. Also cuts text.

Copy 
Copies selected events from Cue List and pastes them on the Clipboard. Also

copies text. 

Paste 
Pastes Clipboard into Cue List.

If no event is selected in the Cue List, Clipboard events are pasted preserving

their original times. 

If any event or events are selected in the Cue List prior to pasting, the events

are pasted offset in time, starting at the time of the first selected event. 

Paste also pastes text.

Clear 
Clears entire mix or selected events, or clears text.

Replace 
Replaces selected events with contents of the Clipboard. 

Paste Special... 
Opens dialogue that permits changing the clipboard data before pasting. 

Select All 
Selects all Viewed events in Cue List. 

Selects all text in a given text field.



Module 
Opens the Edit Module dialogue box. Allows user to design custom modules,

by placing faders, knobs, switches, and labels. These modules can then be

placed anywhere in a Custom View.

Edit Custom Views
Allows you to name the Custom Views, edit the Custom Views one row at a

time, and also restore the original Custom Views.

Channel Names and Labels... 
Opens Names and Labels dialogue box. Names (text) may be applied to each

channel of automation events. Names appear in the Cue List, and also in every

list of channels, the View dialogue box, all the Create dialogues, etc. Channel

labels are the short text fields that are seen under each fader in the Custom

View.

MIDI Names and Labels... 
(Available when OMS or FreeMIDI are not present). Normally, when using

MAX to automate MIDI equipment, the names for MIDI events in the Cue List

are automatically imported from OMS or FreeMIDI. If OMS or FreeMIDI are

not present, the MIDI Names and Labels dialogue box is available for naming

MIDI parameters. Names (text) may be applied to each MIDI channel and

program change.

Mix Comment 
A text field, up to 255 characters long, may be entered for each mix. The

comment is also printed at the top of the Cue List when Print Cue List is

selected.

Show Clipboard 
Displays the current contents of the Clipboard, the most recently Cut or

Copied text or Events. (Close it after you look.)

Preferences 
Opens the Preference dialogue box that allows user to custom configure

certain MAX features. 

Users can create and select from multiple Preference files, so different

Preference files can be saved for different engineers or different kinds of

projects.
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OFF LINE MENU

The Off Line menu contains items relating to the

Cue List.

View the Cue List by selecting Cue List (Command

0) from the Windows menu. 

If the Cue List is not opened, most of the Off Line

items are dimmed (not available).

[Move] Now 
or Scale Now, Smooth Now, Crop Now 

Has the same effect as the Enter key. 

Applies an Edit to selected fader moves.

Tools 
Select one of these tools before editing a fader move. The tools are Move,

Scale, Crop, and Smooth. 

You select them either of two ways: 

From the Tools sub menu, or clicking on one of the 4 buttons on the top left

side of the Cue List

Move 
Change applied to start time affects end time, and vice versa. Change applied

to start level affects end level, and vice versa.

Scale 
Change applied to start or end time squeezes or stretches move. Change

applied to start or end level expands or compresses move.

Crop 
A change to the time or level simply shortens the move.
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Smooth 
The software automatically smoothes the move by changing the level on a

frame by frame basis, and eliminating any irregularities.

Create [event] 
Automation events may be manually created Off Line, by simply choosing the

channels and typing the start and end times. This is especially useful for post

production work where exact start and end points in terms of SMPTE have

been provided for a project, such as a spot for a motion picture or other

commercial jingle.

Create Fader Moves 
Opens a dialogue to allow off line creation of fader moves in the Cue List.

Enter the Level Range. The fader level is entered either as a dB value or as a

numerical value from 0 to 255. (dB or numerical entries are selected in the

Preferences dialogue box.) Enter the Start and End times. Select the channel

numbers that the fader moves will appear on. To the right of the dialogue is

the channel selection list. Click to select which channels will have fader moves

created. Shift-click to select a continuous range of channels. Command -click

to select or de-select multiple discontinuous channels.

Click on “At this time” for the start level of the move, and MAX automatically

finds the level of the channels at the time entered.

Click on “At this time” for the end level of the move, and 

MAX automatically finds the level of the channels at the time entered.

Create Channel On/Off Events 
Opens a dialogue box to allow off line creation of Channel On/Offs in the Cue

List. 

In the Create Channel On/Off Events dialogue box, the current mix name is

displayed.

Select Channel On or Off

Enter the time that the Channel On or Off or In occurs. Channel On/Offs are

entered in of Hours, Minutes, and Frames.

Select Channels

To the right of the dialogue is the channel selection list. Click to select which

channels will have Channel On/Offs created. Shift-click to select a continuous

range of channels.

Command-click to select or de-select multiple discontinuous channels.
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Create Surround Pan Events 
Opens a dialogue box to allow off line creation of

Surround Pan events in the Cue List. 

The current mix name is displayed.

Select Channels

In the right of the dialogue is the channel selection

list. Click to select which channels will have

Surround Events created. Shift-click to select a

continuous range of channels.

Command-click to select or de-select multiple

discontinuous channels.

Enter the Start and End times.

Select Position (From and To)

You can set the pan position either manually or automatically.

To select the position manually, use the mouse to set the starting and ending

pan positions using the graphical interface.

To set the pan position automatically, click “Position at this time in mix” and

MAX will calculate the pan position at the selected time in the mix.
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Create DA7 Parameter Change 
Opens a dialogue box to allow off line creation of other parameters in the

Cue List, such as Pan and Aux send levels.

Enter the Level Range. The Send levels are entered either as a dB value or as a

numerical value from 0 to 255. (dB or numerical entries are selected in the

Preferences dialogue box.) Enter the Start and End times. Select the channel

numbers that the moves will appear on. To the right of the dialogue is the

channel selection list. Click to select which channels will have moves created.

Shift-click to select a continuous range of channels. Command -click to select

or de-select multiple discontinuous channels.

Click on “At this time” for the start level of the move, and MAX automatically

finds the level of the channels at the time entered.

Click on “At this time” for the end level of the move, and MAX automatically

finds the level of the channels at the time entered.

Create DA7 Switch Events
Opens a dialogue box to allow off line creation of other Switch events, such as

EQ On and Pre/Post.

Select the event.

Select On or Off

Time Enter the time that the switch on or off occurs. On and off times are

entered in of Hours, Minutes, and Frames.

Select Channels

To the right of the dialogue is the channel selection list. Click to select which

channels will have switch events created. Shift-click to select a continuous

range of channels.

Command-click to select or de-select multiple discontinuous channels.

Create Snapshots 
Opens a dialogue box to allow off line creation of a Snapshot in the Cue List.

The Snapshot dialogue will either capture the current state of the mixer, or,

the state of the automation at some point in time of the mix. The fader values

displayed will change in real time: move a fader on the mixer and the number

in the dialogue changes. Likewise for channel on/offs. That is, if you press a

SEL Buttons, you will see the status change in the dialogue. Shift Enter

applies fader level to all channels.
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Create MIDI Events 
Opens a dialogue box to allow off line creation of

MIDI Events in the Cue List. Select the type of MIDI

command, the MIDI channel, the Start time, and

any other parameter related to the MIDI event,

such as Controllers, Program Changes, etc.

Create Marker 
Opens the Create Marker dialogue. 

(Click the MARK button in Custom View, or type

Command ;).

Markers are simply text inserted into the Cue List at

a specific SMPTE time. 

Markers help you to locate and edit significant

places within the mix, such as verse, chorus, and scene changes.

Markers may be “Captured” in Real Time, that is, click on the MARK button

while mixer is receiving time code. Markers that are captured in this way do

not have text associated with them yet.

Markers may have their text added or edited by the Edit Marker dialogue box.

To edit a Marker in the Cue List, double click on it to open the Edit Marker

dialogue box. You may edit the Marker’s text, or you may convert the Marker

into some other kind of automation event, either a Snapshot, Fader move,

Channel On/Off, or MIDI Event.

Markers may be found quickly by using the Find and Find Again commands in

the Off Line menu (see below).
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Create Library Events 
Opens a dialogue box to allow off line creation of Library Events in the Cue

List. After opening the dialogue box, first select from the Library menu either

EQ, Dynamics, or Effects.

The names of the Library entries are displayed in the left column. Click to

select the desired Library name.

Then click to select the channel or channels which will be affected by the

Library event. Shift-click to select a contiguous range of channels, command-

click to select any combination of channels.

Type the time that you want the event to occur, and click Create to create the

events and insert them into the Cue List.

Transition Between Snapshots
A “Transition Event” may be inserted between two Snapshots. 

A Transition Event consists of fader moves, that Transition or “dissolve”

between the audio channel levels in each Snapshot.

To create a Transition Event, first select two Snapshots in the Cue List. Then

select Transition Between Snapshots from the Off Line menu. This inserts the

Transition Event. The actual fader moves that comprise the event may be

viewed by clicking on the triangle to the left of the event.

The time that the transition starts is prior to the second Snapshot. The time

may be user set in the Preferences dialogue. To change the time, select

Preferences from the Edit menu. Then click on the Faders tab. Type the time

in the Transitions Between Snapshots field. The time is entered in frames. 

MIDI Faders 
16 of the mixer’s faders may become MIDI Faders. MIDI Faders send MIDI

Controller data when they are moved. The MIDI Controller data may be used

to control parameters and levels of signal processors, hard disk based digital

audio workstations, etc.

(Faders are turned into MIDI Faders in the Custom View, by selecting MIDI

from the Selection pop-up menu in the lower right corner of any module.)

If any MIDI Faders have been created in the Custom View of the mix, they

may be “remapped”, that is, have their Channel and Controller number

changed, in the MIDI Faders dialogue box.
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View Events
Opens a dialogue box that lets you specify what

events in the Cue List may be viewed. Events not

viewed are still part of the mix, but are “filtered”

out of the Cue: List so that they may not be seen or

selected.

Useful for shortening the Cue List to include only

certain events prior to printing or editing. 

Find (Command F) 
Opens Find dialogue. Searches for text in the Cue

List. For example, you can find a Marker called, say, “Second Chorus”, by

typing “Second” and the Return key.

You need not type the whole word. Just type enough of the first letters to

distinguish the text. 

Search may be made of Markers, Snapshots, or both.

Clicking Previous searches back in Cue List for the previous occurrence of

text.

Find Again (Command G) 
Searches Markers or Snapshots for the next occurrence of the text which had

previously been selected in the Find dialogue box. Does not open the Find

dialogue box again.

Find Previous (Command Shift G) 
Finds previous occurrence of text, searching back up to earlier events.
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REAL TIME MENU

This menu is for turning on and off special

features, and for opening dialogues, that

relate to Real Time operation.

Real Time operation means creating and

editing a mix while time code is received.

(As distinguished from Off Line, which

means creating and editing a mix from the

Cue List, by numerically manipulating

discreet automation events.)

Auto Punch In 
Auto Punch In makes Real Time mix editing

easier by automatically switching any

selected fader from Read into Write mode

when the fader is moved across its null

point. 

Auto Punch Out 
Auto Punch Out makes Real Time mix editing easier by automatically

switching any selected fader from Write into Read mode when the fader is

moved across its null point. Auto Punch out must be pre-Selected, that is to

say, you must push a button before you punch out.

SoftTouch 
When SoftTouch is turned on, faders on the mixer behave as if they were

touch sensitive. When the Edit Mode is Write, simply moving any fader selects

it, without pushing a button. There will be no jump in level if Auto Punch is

turned on, because the move will not be written until the null point is

crossed. The fader will return to read mode if it is not moved for a certain

period of time. This time period user-set in the Preferences dialogue box. It is

entered in seconds.

Auto Disable 
When Auto De-select is checked, faders automatically switch from Write to

Read modes when the time code is stopped.

This prevents accidental writing of fader moves on the subsequent pass.

Auto De-select defaults to On (checked). 

There are special circumstances where it might be desirable to turn it off. For

example, if looping the program material and continually trimming the mix, it

may be more convenient to leave Auto De-select off, so that the individual

faders do not have to be “re-Selected” with every pass.
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Group Members Move with Master
When checked, the SoftGroup members move along with the master.

Faders Control Group Master or MIDI
When checked, the mixer’s faders will control either SoftGroup Masters, or

MIDI faders. 

To use this feature, it is necessary to first make a fader into either a SoftGroup

Master or a MIDI fader.

Overwrite
This menu opens the Overwrite dialogue box. Enable each parameter that you

intend to edit in the next pass. Parameters that are not enabled will be “read

only” in the next pass. 

Enable All / Disable All (Command E) 
This instantly selects all faders. If all channels are already Selected, this

instantly de-selects faders, returning them to Read. 

Set All Channels To: 
Moves all the faders in the Custom View up to a user-specified level.

Unsolo All
Disengages all solos.

All Channels On
Turns audio on for every channel.

Motors Off
Turns mixer motors on and off. You can still perform an automated mix with

the motors turned off. 

The Panasonic WR-DA7 Digital Mixer actually controls signal levels using

internal digital signal processors. The moving faders are simply a control

input device and representation of what the internal digital signal processors

are doing. No audio passes through the faders as it does in a traditional

analogue console.

Receive Time Code 
Has the same effect as the T.C. button in the Control Bar. Turn Receive Time

Code on to do an automated mix. Turn off to freely play the program material

without an automated mix playing back, without a snapshot being taken, and

without a message to bring a fader window to the front.
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MIDI Input Filter 
When using the MIDI Record feature,

setting the MIDI Input Filter allows

selective filtering out of specific MIDI

events, by channel and kind. Used to save

memory and avoid recording unwanted

MIDI data.

MIDI Record 
Turns MIDI Record On or Off. When MIDI

Record is On, and time code is received,

the software can record MIDI commands

received on a MIDI interface connected to

one serial port of the Macintosh. This may

be used, for example, to record notes from

a keyboard to fire sampled sound effects.

Open Current Studio Setup
Opens current OMS studio setup, if OMS is

installed.

MMC Devices... 
Opens track arming window. Shows MMC devices defined in OMS setup.

Enable buttons for each track. Number of tracks for each device is set in the

Machine Control tab of the Prefs dialog box.

Group Members Move With Master
When checked, group members move on screen when the group masters or

stereo grand master is moved. 

When not checked, the group members do not move with the master, but

their levels change with the master. This feature only affects the display, and

not how the mix sounds.

Update Configuration 
Makes the Custom View show the current position of the faders. Useful

because at any point in the mix, if “Motors” are off, when you stop the

program material the faders on the screen will not reflect the real position of

the physical faders. 
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Capture Snapshot
A Snapshot is a kind of event which represents the state of all of the mixer’s

automated parameters.

A Snapshot which is inserted into the Cue List then becomes part of the mix,

it can be edited, and it also becomes a locate point.

Send Snapshot 
A Snapshot is a kind of event which represents the state of all of the mixer’s

automated parameters.

One Snapshot is written into the mix at the beginning automatically, more

may be inserted or edited in the Cue List. 

To use Send Snapshot, first select a Snapshot event in the Cue List by clicking

on it once. Then select Send Snapshot. 

This forces the mixer to immediately “Snap” to the state of the selected

Snapshot. This is a means of instantly setting all of the channel on/offs and

faders to some previously written state, all channels at the same time. 

For example, clicking on a Snapshot in the Cue List, and selecting Send

Snapshot, may be used for instantly turning off every channel on the mixer.
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GRAPHIC EDITING MENU

Snap to Markers
Snap to Marker, when checked in the Graphic Editing

menu, makes it easier to align events to markers in the

Graphic view.

When dragging a selected region of fader moves near a

marker, the region will snap to (align with) the marker.

When extending or moving a Channel On/Off, the start or

end of the Channel On/Off will align to the marker.

Show or Hide Marker and Snapshot Names
To show or hide marker names, click on the blue triangles.

To show or hide snapshot names, click on the red triangles.

Show or hide can also be selected from the Graphic Editing menu.

Show or Hide Marker and Snapshot Lines
To show or hide the vertical lines that extend downward from the markers

and snapshots, select Show Lines or Hide Lines from the Graphic Editing

menu.

Auto Smooth
As fader moves are drawn, the software smoothes out any small irregularities. 

It does this automatically when you release the mouse. 

WINDOWS MENU

Selects how you are viewing the active mix in the front most

window, Custom View 1 through 10, Cue List, or Graphic

View.

Below the line are the names of your opened mixes. Select

which mix you will be editing or playing back, that is to say,

which is the active (front-most) window.
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Chapter 16

DA7 LIBRARIAN SOFTWARE

The DA7 Librarian Software allows you to edit and save multiple DA7 libraries

to disk. 

INSTALLATION

To install the software, please refer to "Software Installation" in Chapter 1.

LAUNCHING LIBRARIAN SOFTWARE

Double click to launch the application. The application will automatically

upload the current contents of the DA7 Libraries. This may take some time,

due to the large amount of data that the DA7 can store.



LIBRARIAN WINDOW

A window opens showing a table of Library names, and "Source" and

"Destination" tables. These tables have standard scroll bars to allow you to

scroll down and view more library entries.

On the left is the list of DA7 libraries. You can select and view the contents of

one library at a time. Select either Scene Library, Automation Library, Channel

Library, EQ Library, Dynamics Library or MIDI Remote. 

This only affects what you are viewing and editing. However, when you

actually save a file to disk, or download it to the DA7, understand that all 6

libraries are saved or downloaded at the same time.

The DA7 can internally store has 51 Scene Libraries and 4 Automation

Libraries. 

The DA7 also internally stores 50 of each of the other Libraries.
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SETTING THE PORT AND COMMUNICATION SPEED

Drag down the EDIT from the menu bar to select the  "Port Settings." 

The Port Settings window appears.

Click on a button to select the Port - either Modem or Printer .

Click on a button to select the Speed - either 62.5 k or 125 k, so that it is

identical to how the DA7 is set.

Click OK button.

Set the communication speed on the DA7 - either 62.5 k or 125 k, so that it is

identical to how the Librarian is set. 

Note: After changing the port selection, you will need to close the Librarian

Software once and then restart it.

For more information, see Chapter 11, MIDI of the DA7 Users' Guide.



TO SELECT AND VIEW A LIBRARY

To view a Library's contents, prior to Editing or Saving it, you must first select

it under "Source". Click on either "File..." or "DA7".

Click DA7 to select Libraries currently stored in the DA7 at the time the DA7

Librarian application was launched. (Clicking on DA7 causes the Destination

"DA7" button to "dim", that is, become unavailable.)

Click File... if you wish to select Libraries previously saved in a file.

Clicking File... brings up the standard "Open" dialogue box for selecting and

opening a previously saved Library.

Click to Select from the list of Libraries to choose the Library that you wish to

view and possibly edit and save. 
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TO EDIT AND SAVE

Prior to Editing and Saving, you must first select a "Destination". The

Destination can be a File (that is, save to disk) or the DA7 .

Click DA7 to select the DA7. 

(Clicking on DA7 causes the Source "DA7" button to "dim", that is, become

unavailable.)

Click File... if you wish to select the name of a file to save the Libraries to

disk.

Clicking File... brings up a standard dialogue box to allow you to name the

Destination file. 

But this does not actually save anything to disk yet. You must click on the

Save button at the bottom of the window to save to disk. 

(See warning on the next page)
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TO SELECT LIBRARY ENTRIES PRIOR TO EDITING OR SAVING

First Select the Source as described above.

Then, click to select from the Library list on the left side of the window, as

described above.

View the entries in the selected library, and scroll down to see them all.

Select the entries that you wish to Edit or Save by clicking on them.

Clicking will select one entry, the last entry clicked.

Shift-Click to select a contiguous range of entries.

Command- Click to select or de-select any combination of multiple entries.

Click "Add" to move a copy of those entries to the Destination side of the

window.

You cannot click Add without first selecting a Destination (see above.)

Click "Add All" to move a copy of all entries to the Destination side, without

having to select anything first.

Warning! 
The next time that you click the Save button at the bottom of the

window will result in a "Download", that is, the current contents of

the Destination table will be transferred into the DA7 mixer,

overwriting and irrevocably erasing the previous Library contents!



2 1 3

DA7 Librarian Software

Remember that if the Destination is "DA7", the number of entries on the

Destination side is fixed by the capacity of the DA7. As mentioned earlier, the

DA7 can internally store has 51 Scene Libraries and 4 Automation Libraries. 

The DA7 also internally stores 50 of each of the other Libraries.

If the Destination is a File, there is no practical limit to the number of entries

that can be saved in a Library.

If nothing is selected in the Destination Side, then the Add or Add All button

will cause the selected entries to replace the entries on the Destination side. 

If DA7 is the Destination, you will never have more entries than the DA7 can

hold displayed in the Destination side.

If any entries are selected on the Destination side, clicking Add or Add All will

"replace" the selected "Source" entries starting at the first selected entry on the

Destination side.

The Add operation will also Delete Destination entries as required, until as

many as possible of the Source-selected items are added.
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CLIPBOARD EDITING OF "DESTINATION"
If the destination is a File, you can use the standard clipboard operations,

Cut, Copy, Paste, Clear and Undo, to facilitate the process of editing entries

prior to saving to disk.

TO CHANGE THE NAME OF A LIBRARY ENTRY

Double Click on the Name of the Entry in the Destination side to open the

Edit Name dialogue box. 

Type the new name and press Enter.
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EXAMPLE OF PROCEDURE TO SAVE (BACKUP) DA7 LIBRARY
CONTENTS TO DISK.
Under Source, click to select DA7.

Under Destination, click to select File... and name the File, click OK to close

the dialogue.

Click Save at the bottom of the window to save the DA7 libraries to disk.

EXAMPLE OF PROCEDURE TO OPEN A PREVIOUSLY SAVED FILE
AND DOWNLOAD IT TO THE DA7.
Under Source, click to select File...

Select the File and click OK to close the dialogue box.

Under Destination, click to select DA7. 

At this point, you may want to select individual entries on the Destination

side, to replace entries using Add, starting at the selected entry.

Click Add or Add All to chose the entries that you want to send to the DA7.

At this point, you may edit them further, by editing names, or using the

Clipboard, that is, Cut, Copy, Paste. 
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APPENDIX
MACINTOSH KEYBOARD SHORT CUTS

This is a comprehensive list of MAX’s Macintosh keyboard shortcuts.

The following shortcuts are “direct”, simply type the letter indicated below to

access the desired mode of operation.

Edit Mode Menu Key

Write W

Read R

Trim T

Manual M

MMC Control Panel

Play space

Stop return

Fast Forward Shift \

Rewind Shift [

To use the following shortcuts, press and hold down the Command Key and

while holding the Command key type the letter indicated.

File Menu Key

New  N

Open  O

Close  W

Save  S

Print Cue List  P



Quit  Q

Edit Menu

Undo (Redo)  Z

Cut  X

Copy  C

Paste  V

Clear  B

Select All  A

Off Line Menu

Move  K

Scale  L

Crop  I

Smooth  Y

Create Fades  J

Create Channel Ons  M

Create Marker  ;

Find  F

Find Again  G

Find Previous  Shift-G

Real Time Menu

Enable All (Disable All)  E

Receive Timecode  T

Update Configuration  U

Group Members Move with Master  /
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Faders Control SoftGroups or MIDI  `

Capture Snapshot  ,

Windows Menu

Custom Views 1 - 9  1 -  9

Cue List  0
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STUDIO VISION PRO 4.01 
To use the included Studio Vision Pro 4.01 Template – Assign up to 16 MIDI

Faders in MAX (You only need to do this once. These will be saved with your

prefs). 

Go to the MIDI Faders dialogue box and set the instrument for each MIDI

Fader to IAC Bus. (This will also be remembered console window should

open and the first 16 faders should already be set to respond to volume

messages on the IAC bus. 

At this point, you should be able to move a fader(that was assigned as MIDI

fader) on the DA7 and see one of Vision’s faders move with it. 

To actually control something in Vision, you will of course have to assign its

faders to control its MIDI and/or Audio Tracks. This will vary from sequence

to sequence.
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